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Vorwort

Herzlich Willkommen

Herzlich Wilkommen zum Ubuntu-Handbuch.

Dieses Handbuch wurde als Einflihrung entwickelt, um neuen Benutzern bei der Be-
nutzung von Ubuntu einen Leitfaden an die Hand zu geben. Unsere Zielsetzung ist es, die
Grundlagen von Ubuntu abzudecken — wie zum Beispiel die Installation, die Einrichtung der
Arbeitsoberfliche und beliebter Anwendungen — aber auch eine Einfithrung in Linux und die
Macht von Open-Source zu geben. Das Handbuch wurde darauf ausgelegt, einfach zu folgend
zu sein, mit Schritt-fiir-Schritt-Anleitungen und erlduternden Diagrammen — um Thnen zu
erlauben, das gesamte Potential Thres neuen Ubuntu-Systems zu entdecken, selbst wenn Sie
ein Computerneuling sind, oder zum ersten Mal von einem anderen Betriebssystem wechseln.

Viele Menschen haben ihre Freizeit in dieses Projekt investiert. Das Handbuch befindet
sich noch in der Entstehungsphase und wird sich immer weiter entwickeln. Obwohl wir ver-
suchen sicherzustellen, dass die Anleitungen nicht auf eine bestimmte Version zugeschnitten
sind, ist es unvermeidbar, dass gewisse Dinge sich mit der Zeit in Ubuntu verdndern. Jedes-
mal wenn eine neue Ubuntu-Version erscheint, wird das Handbuch einer Revision unterzogen
und entsprechende Anderungen eingepflegt. Zum Zeitpunkt der Entstehung dieser Version
ist die aktuelle Ubuntu-Version 10.04 LTS.

Wenn Sie irgendwelche Fehler oder fehlende Inhalte bemerken, seien Sie so frei und kon-
taktieren Sie uns. Wir versuchen alles in unserer Macht stehende, um das Handbuch aktuell,
informativ und fehlerfrei zu halten. Unsere Kontaktdaten finden Sie weiter unten.

Was dieses Handbuch nicht ist

Dieses Handbuch soll kein umfassendes Ubuntu-Unterrichtsbuch sein. Es stellt mehr eine
Schnellstart-Anleitung dar, welche Thnen hoffentlich dazu verhilft, schnell und einfach das zu
tun, was Sie wollen, ohne sich in technischen Details verzetteln zu miissen.

If you are after more detail, there are excellent resources available from help.ubuntu.com,
produced by the Ubuntu Docs Team. The in-built system documentation in Ubuntu is also
very useful for accessing help on specific topics. If something isn’t covered here, chances are
you will find the information you are looking for in one of those locations.

Contact details

The Ubuntu Manual Team
Launchpad Team page https://launchpad.net/~ubuntu-manual

Mailing List ubuntu-manual@lists.launchpad.net

More information on the
online docs and the system
docs can be found in
Kapitel 10: Learning more
about Linux.


help.ubuntu.com
https://launchpad.net/~ubuntu-manual
ubuntu-manual@lists.launchpad.net
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Project Wiki Page https://wiki.ubuntu.com/ubuntu-manual

Ubuntu philosophy

Der Ausdruck »Ubuntu« ist ein klassisches afrikanisches Konzept, dass von den Bantu-
Sprachen aus Siidafrika stammt. Es kann als Weg beschrieben werden, sich mit anderen zu
verbinden — in einer Gemeinschaft zu leben, in der das eigene Handeln die gesamte Mensch-
heit beeinflusst. Ubuntu wie wir es kennen, ist mehr als nur ein Betriebssystem: Es ist eine
Gemeinschaft von Menschen, die sich zusammengefunden haben, um gemeinsam Teil eines
internationalen Softwareprojekts zu sein, dessen Ziel es ist, die bestmogliche Benutzererfah-
rung und den bestmoglichen Funktionsumfang eines Betriebssystems zu schaffen, der heute
verfiighar ist.

The Ubuntu promise

= Ubuntu wird immer kostenlos bleiben, einschliellich regelméfliger Unternehmensversionen
und Sicherheitsaktualisierungen.

= Ubuntu verfiigt iiber vollstdndige kommerzielle Unterstiitzung von Canonical und Hun-
derten von Firmen weltweit.

» Ubuntu bietet die besten Ubersetzungen und Barrierefreiheitsfunktionen, welche die Freie
Software-Gemeinde zu bieten hat.

= Die Kernanwendungen von Ubuntu sind alle frei und Open-Source. Wir méchten, dass
Sie freie und Open-Source-Software benutzen, verbessern und weitergeben.

A brief history of Ubuntu

Ubuntu wurde 2004 von Mark Shuttleworth, einem erfolgreichem siid-afrikanischem Unter-
nehmer und seiner Firma, Canonical ins Leben gerufen. Shuttleworth erkannte die Macht
von Linux und Open-Source, aber ebenso ihre Schwéchen, die sie vom Durchschnittsbenutzer
fern hielten.

Shuttleworth setzte klare Ziele um die Schwéchen zu beseitigen und ein einfach zu be-
nutzendes, vollkommen freies und von jedem zu verwendende Betriebssystem zu erschaffen.
Mit dem Betriebssystem Debian als Codebasis begann Shuttleworth, Ubuntu zu entwickeln.
Auf seine eigenen finanziellen Mittel zuriickgreifend wurden kostenlose Installations-CDs ge-
presst und weltweit ausgeliefert, ohne Kosten fiir den Endnutzer. Ubuntu verteilte sich schnell
und die Grofe der Gemeinschaft wuchs rasend, so dass es schnell zu der beliebtesten Linux-
Distribution wurde.

Now with more people working on the project than ever before, Ubuntu has seen continual
improvement to it’s core features and hardware support, and has also gained the attention
of large organizations worldwide. For example in (year????), Dell began a collaboration with
Canonical to sell computers with Ubuntu pre-installed. Additionally in 2005, the French

Canonical, das finanziell
unterstiitzende
Unternehmen, betreibt die
Unterstiitzung fiir Betreuung
des Ubuntu-Kerns. Es hat
weltweit iiber 200 bezahlte
Mitarbeiter, welche
sicherstellen, dass die Basis
des Betriebssystems stabil
ist und die von Freiwilligen
geleistete Arbeit iiberpriift.
Um mehr iiber Canonical zu
erfahren, gehen Sie auf
http://www.canonical.com
(englisch)


https://wiki.ubuntu.com/ubuntu-manual
http://www.canonical.com

vorwort xi

Police began to transition their entire computer system to Ubuntu, a process which has
reportedly saved them millions of Euro in Windows licensing fees.

By the year 2012, the French Police expect that all of their computers will be running
Ubuntu. Canonical profits from this arrangement by providing technical support and custom-
built software.

Wiéhrend grofle Unternehmen es haufig als niitzlich empfinden, fiir Unterstiitzungsdienste
zu bezahlen, hat Shuttleworth versprochen, dass Ubuntu-Desktopsystem immer kostenlos
bereitzustellen. Im Jahre 2010 ist Ubuntu auf anndhernd 2% aller Rechner weltweit installiert.
Diese Zahl mag klein erscheinen, entspricht aber Millionen von Benutzern weltweit — mit
jahrlichem Wachstum.

Linux

Ubuntu is built on the foundation of Linux, and is just one of many different Linux ‘distri-
butions’ Linux is a type of operating system, and is itself a member of the Unix family, one
of the oldest types of operating systems dating back to the 1970s. Originating long before
Microsoft Windows, the Unix operating systems have provided reliability and security in
professional applications for almost half a century. Many servers around the world that hold
information for popular websites, for example, Facebook and Google run some variant of a
Unix system.

Linux was designed from the ground up with security and hardware compatibility in mind,
and is currently the most popular Unix-based operating system. Initially, Linux was entirely
command line based. Early Graphical User Interfaces (GUIs) began to emerge in the late
1980s, but they were difficult to configure and clunky at best, meaning that only seasoned
computer programmers knew how to use them. In the past decade however, user-friendly
graphical desktop environments have come a long way. Ubuntu uses GNOME, one of the
more popular desktop environments.

MISSING SCREENSHOT
Screenshot of the entire default GNOME desktop and nautilus

Ist Ubuntu das Richtige fiir Sie?

Ubuntu, and Linux in general, is very different than Windows, but users coming from Mac
OS X may see some similarities due to the fact both these operating systems are built on
UNIX. Before you decide whether or not Ubuntu is right for you, we suggest taking the
following into account:

= Ubuntu ist gemeinschaftsbasiert — es lebt von der Gemeinschaft, wurde von der Gemein-
schaft entwickelt und von der Gemeinschaft betreut. Aus diesem Grund werden Sie in Th-
rem PC-Laden um die Ecke keine Unterstiitzung erhalten — die Angestellten werden sehr
wahrscheinlich noch nicht einmal was von Ubuntu gehort haben. Wenn etwas nicht funk-
tioniert, werden Sie sich eventuell selber drum kiimmern miissen! Gliicklicherweise ist die

For information on Ubuntu
Server Edition, and how you
can use it in your company,
visit
http://www.ubuntu.com/
products/whatisubuntu/
serveredition/features

See Kapitel 2: Uber Ihre
Arbeitsflache to learn more
about GNOME and other
desktop environments.


http://www.ubuntu.com/products/whatisubuntu/serveredition/features
http://www.ubuntu.com/products/whatisubuntu/serveredition/features
http://www.ubuntu.com/products/whatisubuntu/serveredition/features

vorwort  xii

Gemeinschaft da, die Thnen hilft. Es gibt eine grofle Zahl von Artikeln, Leitfaden, Hand-
biichern und Benutzer in verschiedenen Internetforen, die bereit sind, Ubuntu-Neulingen
zu helfen — Dorthin sollten Sie sich wenden, wenn etwas nicht lauft.

Windows or Mac applications won’t run on Ubuntu. For the vast majority of applications
that most people use, there are suitable free alternatives available in Ubuntu. The rest are
generally professional applications (such as the Adobe Creative suite) — if you absolutely
cannot live without the latest Adobe software, then Ubuntu may not be for you.

Spieleentwickler entwickeln ihre Spiele normalerweise fiir den gréfiten Markt, wo das meis-
te Geld zu verdienen ist. Da Ubuntu nicht so weit verbreitet ist wie Windows oder Mac,
entwickeln die wenigsten Spieleentwickler fiir Ubuntu, da fiir den Aufwand zu wenig Pro-
fit zu erwarten ist. Wenn Sie ein leidenschaftlicher Spieler sind, kénnte Ubuntu nichts fiir
Sie sein. Wenn Sie gerne altere Spiele spielen, konnen Sie bestimmte beliebte Spiele unter
einem Windows-Emulator namens Wine (siche Kapitel XX) betreiben. Natiirlich gibt es
auch speziell fiir Ubuntu entwickelte Spiele, welche einfach iiber das Software-Center zu
installieren sind.

You may want to consider
dual-booting, which allows
you to run Ubuntu
side-by-side with another
operating system. See
Kapitel 1: Installation.
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1 Installation

Ubuntu beziehen

Ubuntu ist in vielen Arten und Formen verfiigbar, was es Thnen erlaubt, die fiir Sie am
geeignetste Version auszuwahlen. Alle Linux-Distributionen sind, theoretisch, gleich — Nur
mit unterschiedlichen Kerneln und Paketen vorinstalliert.

Server- und Desktopeditionen benoétigen unterschiedliche Programme fiir ihre Zwecke.
Zum Beispiel bendtigt ein Server keinen Mediaplayer, im Gegensatz zu einem Desktopsystem.
Der Benutzer konnte sein System selbststéndig dementsprechend einrichten, was aber Zeit
und Miihe kosten wiirde — deswegen liefert Ubuntu verschiedene Versionen mit entsprechend
vorinstallierten Programmen aus, um Thnen das Leben einfacher zu machen.

Ubuntu herunterladen

Wenn Sie Ubuntu herunterladen moéchten, haben Sie dazu verschiedene Moglichkeiten. Die
einfachste Moglichkeit ist es, das CD-Abbild direkt von http://www.ubuntu.com (englisch)
herunterzuladen. Wenn gerade eine neue Version erschienen ist, ist es schneller Ubuntu iiber
Torrents herunterzuladen — Die Server werden verstopft, wenn nach der Verdffentlichung
jeder sein System aktualisiert.

After you've downloaded the CD image, all you have to do is burn it to a CD.

Eine kostenlose CD bestellen

You can order a free CD from Canonical if the above method seems too hard, or you have
limited bandwidth or a slow connection. There is no shipping cost or charge to order a CD.
Simply visit www.ubuntu.com and choose to get a free CD — you will have to create an
account but this is very simple and not time consuming at all. The CD usually takes about
four weeks to ship, so if you need Ubuntu in a hurry, downloading it and burning it to a disc
would be the best method.

Ubuntu installieren

Ubuntu ist einfach zu installieren. Die Installation verlduft sehr linear und schnell, so dass die
meisten Menschen keinerlei Probleme damit haben sollten, Thr System aufzusetzen. Obwohl
es sehr einfach zu installieren ist, haben wir eine Schritt-fiir-Schritt-Anleitung erstellt, um
sicher zu gehen, das nichts schiefgeht! Wie empfehlen allerdings, vor der Installation die Live-
CD auszuprobieren, um zu sehen, ob es IThnen geféllt und ob Ubuntu problemlos mit Threr
Hardware zusammen arbeitet.

Ein Kernel ist der zentrale
Bestandteil eines
Betriebssystems,
verantwortlich fiir die
Ausfiithrung von
Programmen.

In Kapitel 10 erfahren Sie
mehr iiber die verschiedenen
Distributionen

To find out how to burn a
CD on your computer, refer
to your operating system or
manufacturer help. You can
also find help here:
https://help.ubuntu.com/
community/
BurninglsoHowto


http://www.ubuntu.com
https://help.ubuntu.com/community/BurningIsoHowto
https://help.ubuntu.com/community/BurningIsoHowto
https://help.ubuntu.com/community/BurningIsoHowto
www.ubuntu.com
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Die Live-CD

Ubuntu besitzt eine exzellente Funktion, welche es Thnen erlaubt, es vor der Installation
auszuprobieren, auch wenn Thnen dabei nicht alles zur Verfiigung steht. Es lauft direkt von
der CD im Arbeitsspeicher Thres Rechners, wird sich dabei aber etwas zah anfithlen (da die
CD-Lesegeschwindigkeit langsamer als bei Festplatten ist und eine Menge an Arbeitsspei-
cher benotigt wird), aber es gibt Thnen bereits ein Gefiihl dafiir, wie Ubuntu funktioniert.
Die Live-CD erlaubt es Thnen, alle vorinstallierten Anwendungen zu testen, mit den Vorga-
beeinstellungen zu experimentieren und im Internet zu surfen.

Das ist nicht nur praktisch, um einen Eindruck vom Betriebssystem zu erhalten, sondern
auch um zu testen, ob es problemlos mit Ihrer Computerhardware funktioniert.

Um von der Live-CD zu starten, legen Sie die Ubuntu-CD in Thr CD-/DVD-Laufwerk und
starten Sie den Rechner neu. Die Startreihenfolge wird normalerweise im BIOS festgelegt,
oder Thr Rechner gibt Thnen die Moglichkeit, beim Hochfahren per Tastenkombination von
der CD zu starten. Ziehen Sie Ihr Benutzerhandbuch fiir weitere Informationen zu Rate.

Sie werden ein Auswahlmenti dhnlich dem folgenden sehen:

MISSING SCREENSHOT

Installation CD boot menu

Waihlen Sie die Option “Ubuntu ausprobieren, ohne Thren Rechner zu verdndern” und
driicken Sie die Enter-Taste auf IThrer Tastatur, um von der Live-CD zu starten.

Wubi verwenden

Wubi steht fiir Windows-Ubuntu-Installer und erlaubt es Thnen, Ubuntu unter Windows
zu installieren. Nach der Installation erscheint Ubuntu wie jede andere Anwendung unter
»Programme Entfernen/Hinzufiigen«. Wenn Sie Ubuntu installieren, legt es eine gewisse
Zahl an grofien Dateien (die sogenannten Loop-Dateien) an, fiir welche Sie die Gré8e angeben
kénnen und in welchen es alle Dateien von Ubuntu installiert. Es fligt ebenso einen Eintrag
zum Windows-Bootloader hinzu, so dass Sie wahrend des Hochfahrens wahlen kénnen, ob
Sie Ubuntu oder Windows starten mochten.

Das ist der einfachste Weg, ein sogenanntes Dual-Boot-System einzurichten und Ubuntu
direkt auf Threm Rechner auszuprobieren — Und es, falls es Thnen nicht geféllt, einfach wieder
zu deinstallieren. Es wird Ihre Windowsinstallation in keinster Weise beeinflussen.

Es gibt allerdings einige Dinge, die Sie dabei im Hinterkopf behalten miissen:

= Wenn Sie Ubuntu mit Wubi installiert haben und feststellen, dass es Thnen geféllt und
Sie gerne mehr Festplattenplatz dafiir hatten, ist es sehr schwierig den Festplattenplatz
zu erhohen, ohne Ubuntu komplett neu installieren zu miissen.

= Die Lese-/Schreibgeschwindigkeit wird nicht so schnell sein wie wenn Sie Ubuntu direkt
auf Threr Festplatte an Stelle einer virtuellen Festplatte installiert hétten. Die Einbufien
werden allerdings nicht grofl ins Gewicht fallen.
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Installing Ubuntu to your hard drive

Um Ubuntu direkt auf Ihrer Festplatte zu installieren, bendtigen Sie mindestens 3 GB freien
Festplattenspeichers, um das Basissystem zu installieren. Wir empfehlen 10 GB um ein wenig
Platz fir zuséitzliche Programme und Ihre eigenen Daten zu haben. Sie kénnen Ubuntu
entweder iiber Windows driiber installieren und Windows damit 16schen, oder Sie installieren
es neben Windows als Dual-Boot-System. Sie konnen sich wiahrend der Installation zwischen
den beiden Moglichkeiten entscheiden.

Recommended system requirements:

Ubuntu sollte hinreichend gut auf Rechnern mit den folgenden minimalen Hardwareanforde-
rungen laufen.

700 MHz x86-Prozessor

384 MB Arbeitsspeicher (RAM)

8 GB freien Festplattenspeicher

Eine Grafikkarte, die mindestens eine Auflésung von 1024x768 darstellen kann

Soundkarte

FEine Netzwerk- oder Internetverbindung

First steps of installation

Um zu starten, legen Sie die Ubuntu-CD in Ihr CD-/DVD-Laufwerk und starten Sie Thren
Rechner von der CD.

Choose your language with the arrow keys, and press enter to select one.

MISSING SCREENSHOT

Language options

Press the down arrow so that Install Ubuntu is highlighted, then press enter on the
keyboard.

MISSING SCREENSHOT
Boot CD main menu with Install Ubuntu highlighted

Warten Sie kurz einige Sekunden, wihren die CD in den Arbeitsspeicher geladen wird.

Weéhlen Sie Thre Landessprache und klicken Sie Weiter um fortzufahren.

Ubuntu wird auch auf
Rechner mit weniger als den
geforderten Anspriichen
laufen, aber Sie werden die
Alternate-CD zur
Installation verwenden
miissen.

Alle 64-bit (x86-64)-Rechner
sollten in der Lage sein, mit
Ubuntu zu laufen.
Verwenden Sie die
64-bit-Installations-CD fur
eine auf 64-bit optimierte
Installation.

You can choose Check disc
for defects to make sure no
errors were encountered
when burning your CD. You
can also test your memory
by choosing Test memory.
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MISSING SCREENSHOT

‘Where are you? Screen

Tell Ubuntu where you are located by clicking on your location. This will set the system
clock for you. You can also use the drop down list at the bottom of the screen. Click
forward to move on.

MISSING SCREENSHOT

First installation screen

In this screen, you need to tell Ubuntu what keyboard you are using. For most people,
the default option should be satisfactory. Click forward to continue once you have tested
your keyboard.

MISSING SCREENSHOT
Keyboard Screen

Guided partitioning

Dieser Bildschirm erlaubt es Ihnen auszuwéhlen, wo Sie Ubuntu installieren moéchten. Wenn
Sie Thr bestehendes Betriebssystem tiberschreiben moéchten oder eine leere Festplatte be-
nutzen und den Installer automatisch die Partitionierung Ihrer Festplatte festlegen lassen
mochten, wihlen Sie die zweite Option Gesamte Festplatte verwenden.

MISSING SCREENSHOT

Partitioning screen

If you already have another Operating System installed on your hard drive, and want to
install Ubuntu alongside it, choose Install them side by side, choosing between them
each startup.

Manuelle Partitionierung

Diese Option ist fiir erfahrene Benutzer, welche spezielle Partitionen erstellen oder ein anderes
als das vorgegebene Dateiformat verwenden méchten. Sie kann aber auch verwendet werden,
um eine separate Home-Partition zu erstellen, was sehr niitzlich sein kann, wenn Sie den
Rechner eines Tages neu installieren mochten.

Wer sind Sie?

MISSING SCREENSHOT

‘Who are you? Screen
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Hier miissen Sie folgende Angaben machen:

Thren echten Namen

Thren gewiinschten Benutzernamen

Thr gewiinschtes Passwort

Wie Sie Ihren Rechner nennen wollen

Und wie Sie sich bei Ubuntu anmelden wollen.

Die ersten drei Schritte sind selbsterkldarend. Wéhlen Sie einen einfachen Benutzernamen,
oftmals Thren Vornamen, komplett klein geschrieben. Ihr Passwort sollte sicher und schwer
zu erraten sein.

Der Name Thres Rechners kann sein was immer sie mochten, auch wenn die meisten
Menschen etwas wie “Hans-Desktop” oder “Hans-Laptop” wéhlen. Der Name wird bendétigt,
um Thren Rechner im Netzwerk von anderen zu unterscheiden.

Sie haben die Wahl, sich auf drei verschiedene Art und Weisen anzumelden:
Automatische Anmeldung

Ubuntu wird Sie anmelden, sobald Sie Thren Rechner starten. Das bedeutet, dass Sie kein
Passwort eingeben miissen - aus Sicherheitsgriinden nicht empfohlen.

Passwort wird zum Anmelden bendtigt

Das ist die empfohlene Option - alles was Sie tun miissen, wenn Sie Thren Rechner starten,
ist Thr Passwort einzugeben. Das verhindert unbefugten Zugriff zu IThrem Rechner.

Passwort wird zum Anmelden und Entschliisseln des Heimverzeichnisses bendétigt

Thr Heimverzeichnis ist das Verzeichnis, in dem alle Thre Daten gespeichert werden. Wenn
Sie diese Option wahlen, wird Ubuntu Ihr Heimverzeichnis automatisch verschliisseln, so dass
man nicht darauf zugreifen kann, bis Sie Ihr Passwort eingegeben haben. Selbst wenn jemand
physischen Zugriff auf Thre Festplatte hat, kann er nicht auf Thre Daten zugreifen, ohne Thr
Passwort eingegeben zu haben. Das ist ziemlich sicher und wird empfohlen.

Bestatigen Sie lhre Angaben und starten Sie die Installation

Nichts was Sie bisher angegeben haben wurde bis hierhin auf die Festplatte geschrieben,
stellen Sie sicher dass alle Ihre Angaben korrekt sind und klicken Sie Install um den Instal-
lationsprozess zu starten.

MISSING SCREENSHOT

Confirmation Screen
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Ubuntu will now install, and, as it does so, you will be presented with a slideshow that
gives you an introduction to some of the default applications included with Ubuntu.

MISSING SCREENSHOT

First slide in the slideshow

After approximately twenty minutes, the installation will complete and you will be able
to click Restart Now to restart your computer and boot into Ubuntu. The CD will be
ejected, so remove it from your CD drive and press Enter to continue.

MISSING SCREENSHOT

Screenshot of "restart now” dialog box
After the splash screen, you will see the login window:

MISSING SCREENSHOT
Screenshot of the GDM login

Klicken Sie auf IThren Benutzernamen und geben Sie Thr Passwort ein und driicken Sie
anschliefend Enter oder klicken Sie auf Anmelden um sich bei Ubuntu anzumelden.



2 Uber Ihre Arbeitsfliche

The GNOME Environment

GNOME (abbreviation of GNU Network Object Model Environment) is a desktop environ-
ment (DE). The GNOME desktop environment is the default environment used in Ubuntu.
Most of the desktop you see in front of you will be part of GNOME. Although the GNOME
desktop environment is highly customizable (as is true with many of Ubuntu’s features), we
will deal with the default desktop, as described below.

Understanding the Desktop
The Desktop

Much like Windows or Mac OS, Ubuntu has a desktop screen from which everything else
orginiates. By default, the desktop will have panels at the top and bottom of the screen. The
screen itself will have a wallpaper that is part of the default Ubuntu theme, known as the
Human Theme. The desktop is highly customizable. You can move the panels to the sides of
the screen, or remove them altogether and replace them with a dock similar to that of Mac
OS X. You can change the wallpaper, and even place program launchers or file shortcut icons
on the desktop. For now, we will look at the default screen and the options that it offers. As
we move forward in this chapter, you will learn how to make some basic modifications to the
desktop.

The Top Panel

As previously mentioned, the default Ubuntu desktop has panels at the top and bottom of
the screen. We will briefly look at the features on the top panel. Starting from the left, you
will see three menu headings: Applications, Places, and System. After that, you will see two
program icons; the Firefox web browser launcher, and the Ubuntu Help launcher. To the
right of the panel you'll find the Notification Area, which is similar to the system tray in
Windows. To the right of that is a menu with the name you entered during installation.
This menu interfaces with the Empathy IM client, which is installed by default in Ubuntu
10.04. Finally, on the far right, is the power button icon. When you click on it, a menu drops
down that offers options for locking down your computer, logging yourself out, restarting, or
shutting it down completely.

The top panel is customizable. Just right-click on any open area of the panel to access the
options menu. You can add applets to the panel for reference, information, or fun. You can
also add program launchers to the top panel by opening the Applications menu. Once you
find the program, drag it to an open space on the panel. In this way, the panel also serves as
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an applications dock. You can also adjust panel properties, such as orientation of the panel
on the screen (top, bottom, left, right), panel size, and panel color and transparency.

The Notification Area

Just as Windows has the System Tray, Ubuntu has the Notification Area. The items that
you’ll find there include the volume adjustment, network indicator, Bluetooth indicator (if
your computer has Bluetooth capability), new mail notification applet, and the date and time.
Some programs will install an icon in the Notification Area when you first open them, such
as Tomboy Notes, and other programs will put an icon there when modifications are made
in the program. For example, if you adjust the settings in Open Office so that it will load
in the background (for faster startup when you need to look at a document, etc.), an Open
Office icon will appear in the Notification Area. Right-clicking any icon in the Notification
Area will bring up a menu with options available. For example, right-clicking the volume
icon will allow you to mute the speakers or access the Sound Preferences window, where you
can not only adjust volume, but you can choose sound themes and check sound card and
microphone settings. Features are also available when you left-click icons in the Notification
Area. To adjust the volume, just click on the volume adjustment icon and the volume slider
will appear. When you click on the date and time, a calendar drops down. If you use the
Evolution mail client, you can click on a date on the calendar and it will open up your
Evolution calendar on the date you clicked. Below the calendar is the Location box. Click
the + sign to show the world calendar. To enter your location, click the Edit button. In the
window that opens up, click the Add button. Type your location in the box. If you live in a
major city, it may be on the list already. If your location isn’t in the list, you can enter the
latitude and longitude for your location (you can search on Google if you don’t already have
this information). Don’t forget to select the time zone for your location. If your location is
on the list, you will be able to display weather data for it below the calendar.

The Bottom Panel

The bottom panel is where your open programs minimize to, much like the taskbar in Win-
dows or the bottom portion of the OS X Dock. On the far left of the panel is the Show
Desktop icon. When clicked, all programs on the screen will minimize and you will see your
desktop. Click it again to re-open any windows you had open. On the far right side of the
panel, youll find the workplace switcher. By default, it is set for two workspaces (virtual
screens, if you will). To switch workspaces, just click on the portion of the switcher that isn’t
highlighted. This makes it possible to, say, have a web browser open in one workspace, and
a text document you’re working on in the other workspace, thus reducing clutter on your
screen. To add more workspaces, right-click on the icon and select Preferences. For example,
if you would like to have four workspaces you could select 2 rows by 2 columns (or 1 row by
4 columms). Also on the right side of the panel is the Trash Bin applet. This is much like the
Recycle Bin in Windows or the Trash in OS X. Any files you delete go to the Trash Bin. To
see the contents of the Trash Bin, click on it to open its window. Once the window is open,
you can empty the trash by clicking on the Empty Trash button. You can also empty the
trash by right-clicking the Trash Bin and selecting Empty Trash from the menu.
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Managing Windows

Managing your program windows in Ubuntu works in much the same way as Windows and
OS X. Your typical program window will have an icon or button of some sort in the top left
corner of the window. When that button/icon is right-clicked, a menu will appear with some
window options (i.e. Minimize, Maximize, Always on Top, etc). You will also notice that the
name of the program or file is displayed on the top of the window frame.

Closing, Maximizing, Restoring, and Minimizing Windows

To close a window, click on the “X” in the upper right corner of the window. Just to the left
of the “X” is a box-shaped icon that when clicked will “maximize” the window, making it
fill the entire screen. Click the maximize icon a second time, and the window will return to
its original size. If you want to minimize the window to the lower panel, click the “-” icon.
To display the window on the desktop again, click the spot on the lower panel where the
window’s name is displayed.

Moving and Resizing Windows

To move a window around the workspace, place the cursor on the top of the window, then
click and drag the window. To resize a window, place the cursor on and edge or corner of the
window so that it turns into a larger arrow, the resize icon. You can then click and drag to
resize the window.

Switching Between Tasks

Ubuntu offers you two ways to switch between tasks when you have multiple windows open
in a workspace. You can locate the window on the bottom panel taskbar and click to bring
it up on the screen, or you can use ALT+Tab to select the window you wish to work on.
Hold down the ALT key, and keep pressing the Tab button until you have the window you’re
looking for.

Getting Help

Ubuntu, just like other operating systems, has a built-in help reference, called the Ubuntu
Help Center. To access it, click on the Help icon (by default, the icon is a blue circle with a
white question mark (?7) in the middle). You can also access it as “Help and Support” through
the System menu on the top panel. If you can’t find an answer to your question in the Help
Center, you can reach out to the Ubuntu community through the Ubuntu Forum. Many
Ubuntu users open an account on the Forum to receive help. Later, as they gain knowledge
of Ubuntu, they provide help to others. Another good resource for obtaining answers is
Google. You may find that your question has been already been asked and answered just by
using a few keywords in the Google search engine.

The Ubuntu Forums can be
accessed at
http://ubuntuforums.org.
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Using the Applications Menu

We mentioned earlier that the top panel contains three menu headers. Let’s take a look at
those menus in a bit more detail, starting with the Applications menu.

Accessories

The Accessories sub-menu has many programs that are suited for productivity, including
Calculator and Tomboy Notes. Other programs in Accessories include the CD/DVD Creator,
gEdit text editor (similar to Windows Notepad and OS X’s TextEdit), Search for Files (we’ll
discuss that later), and Take Screenshot, which allows you to take a picture of your desktop
screen.

Games and Applications

Ubuntu has several games built in for your entertainment. If you enjoy card games, check
out AisleRiot Solitaire. Perhaps you’re looking for more of a challenge: in that case, there’s
gBrainy and Sudoku. The Games menu also includes Mahjongg, Mines (similar to Windows
Minesweeper game) and Quadrapassel (similar to Tetris).

Graphics

Under the Graphics sub-menu, you’ll find the F-Spot photo manager, OpenOffice Drawing,
and some scanner applications.

Internet

The Internet sub-menu is where you will find the Firefox web browser, Empathy IM client,
and Ubuntu One, an online storage site that syncs with your Ubuntu data.

Office

The Office sub-menu is where you will find your OpenOffice programs (word processing,
spreadsheet, etc.), the Evolution mail client, and an on-line dictionary.

Sound and Video

The Sound and Video sub-menu has progarms for working with multimedia, such as the Bra-
sero Disk Burner, Totem Movie Player, Pitivi Video Editor, Rhythmbox Music
Player, and Sound Recorder.

Ubuntu Software Center

At the very bottom of the Applications menu is the Ubuntu Software Center. This ap-
plication gives you access to a library of free software that you can download. The main
screen in the Software Center is similar to your Applications menu, for easy searching. If you
know the name of the program you’re looking for, just enter it in the search box on the top

See Kapitel 3:
Standardanwendungen for
more information about the
included applications.

See Kapitel 5: Software and
Packaging for more
information about the
Ubuntu Software Center
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right of the Software Center window. The Software Center keeps track of programs that are
installed on your computer. If you’re simply curious as to what is available, you can explore
the software available using the categories listed on the left side of the window.

Using the System Menu

The system menu, located on the top panel, contains two important sub-menus. Those sub-
menus, Preferences and Administration, make it possible for you to make modifications to
how your system looks and works. Through the System menu, you can also open the Ubuntu
Help Center (Help and Support), find out more about your GNOME desktop environment
(About GNOME), and find out more about Ubuntu in general (About Ubuntu). The System
menu and its sub-menus are the equivalent of the Control Panel in Windows and OS X’s
Systems Preferences.

Preferences

The Preferences sub-menu is where you go to modify the Appearance of the desktop and
windows, assign a default printer, designate keyboard shortcuts, change the entries listed in
the Main (Applications) menu, edit network connections, and change mouse settings, among
other options.

Administration

The Administration sub-menu contains programs you can use to monitor computer perfor-
mance, change disk partitions, activate third-party drivers, manage all installed printers, and
manage how your computer receives updates from Ubuntu. This sub-menu also has the Syn-
aptic Package Manager, which is a more technical resource for locating and downloading
software packages.

Browsing Files on Your Computer

There are two basic ways to locate files on your computer. You can use the Search for Files
tool in the Applications menu, under Accessories. You can also use the Places menu on the
top panel.

Places Menu

The Places menu is, essentially, a list of commonly used folders (such as Home Folder, Do-
cuments, Music, Downloads). You can also browse all disks on the computer by clicking on
Computer in the Places menu. If you set up a home network, you will find a menu item
to access shared files/folders. You can also access the Search for Files tool from the Places
menu, and browse a list of recently opened documents.

Your Home Folder

The home folder is where each user’s personal files are located. When you installed Ubu-
ntu, you entered a name to set up your user account. That same name is assigned to your

See Kapitel 4: Preferences
and Hardware for more
detailed information about
the options available in the
System menu.
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folder in the Home Folder. When you open your personal folder, you will see that there
are several folders there - Desktop (any files that are located on the Desktop), Documents,
Downloads, Music, Pictures, Public, Templates, and Videos. You will also see a link named
Examples. Double- click that link to open a folder full of example documents, spreadsheets,
and multimedia.

Nautilus File Browser

Just as Windows has Windows Explorer and OS X has the Finder to browse files and folders,
Ubuntu uses the Nautilus file browser by default. We will now look at the features offered
in Nautilus.

The Nautilus file browser window

When you open a folder on the Desktop or from the Places menu, the Nautilus file browser
window opens up. The standard browser window contains the following features:

= Menu Bar: The menu bar is located at the top of the window. These menus allow you to
modify the layout of the browser, navigate, bookmark commonly used folders and files,
and view hidden folders and files.

= Icon Bar: The icon bar has tools for navigation and a tool to make the contents of the
window larger or smaller. A drop-down box gives you the option of switching the view
from Icon View to List View or Compact View. The search icon (which looks like a
magnifying glass) opens up a box so you can search for a file by name.

= Additional Navigation Tools: Just below the Icon Bar, you will see a representation of
where you are currently browsing, similar to the “tree” you find on many forum sites.
You can click on the locations to navigate back through the file browser.

= The left pane of the file browser has shortcuts to commonly used folders. When you
bookmark a folder, it appears in the left pane. No matter what folder you open, the
left pane will always contain the same folders. This left pane can be changed to display
different features by clicking the down arrow beside “Places” near the top.

= The largest, central pane shows the files and folders in the directory that you’re currently
browsing.
Opening Files

To open a file, you can either double-click on its icon or right click and select Open With
(program).

If you bookmark a folder, it
will appear in the Places
menu.
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Copying and Moving Files and Folders

Copying files can be done through the Edit menu in Nautilus (either using Copy or Copy
To), or by right-clicking on the file and and selecting Copy or Copy to from the pop-up menu.
When using the Edit menu in Nautilus, make sure you've selected the file (click on it to
highlight it) before you click on the Edit menu. Multiple files can be selected by holding the
left mouse button down while dragging the cursor across the files you want. The click-drag
move is good when you are selecting files whose icons are grouped together. To select files
that are not grouped together, hold the CTRL key down and click on each file you wish to
select.

To move files and folders around, locate the file or folder you want to move. Click and
hold on the file or folder and drag it to the new location. Another way of moving folders or
files is to use the Copy command, followed by Paste in the new location.

Navigating Between Directories

To navigate between directories, use the bookmarks in the left pane of the Nautilus file
browser. You can also retrace your steps by clicking the name of a folder where it is listed
just below the navigational icons. Double-clicking a visible directory will cause you to navigate
to it in Nautilus.

Creating New Folders

To create a new folder, you can either right-click in the file browser window (or on the
Desktop) and select Create Folder from the pop-up menu, or select Create Folder from the
File menu in Nautilus. If you wish to hide certain folders or files, just place a dot (.) in front
of the file name (i.e. “Personal Finances”).

Using Multiple Tabs and Multiple Nautilus Windows

The Nautilus file browser gives you the option to do tabbed browsing as an alternative to
opening several Nautilus windows. To open new tabs in Nautilus, select New Tab from the
File menu. If you prefer having separate Nautilus windows open, select New Window from
the File menu. You can move files and folders using the drop-and-drag method using either
separate windows or tabbed browsing. When you open a new tab, it will produce a second
window of the current directory that you’re working in. To select a different directory for the
new tab, navigate to the desired location using the left pane.

Searching for Files on Your Computer

Eariler, we found that you can search for files on the computer by using the Search for
Files feature on the Places menu in the top panel. We also discovered that you can use the
Nautilus browser to search for files, as explained above. Some files or folders may have dot
(.) in front of the file/folder name. Those files/folders are hidden files. To display hidden files
in Nautilus, select “Show Hidden Files” from the View menu in the file browser or press
CTRL+H.

You can view hidden files by
clicking the “View” menu
and then clicking “Show
Hidden Files” or by pressing
CTRL+H.
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Customizing Your Desktop

Now that you’ve been thoroughly introduced to the GNOME desktop environment, let’s take
a look at customizing its features.

Appearance

There are many things you can do with the desktop appearance. The panels can be moved
from their top/bottom positions to the sides of the screen, they can be set to hide, or you can
change the panel color. To access these features, right-click the panel you want to modify and
select Properties from the pop-up menu. The General tab has options to autohide, position
the panel, and change the panel size. By default, the panels cover the entire length of the
desktop. To change that, un-check the Expand box. To hide the panel on the left or right
corner of the desktop, select the Show Hide Buttons. To put arrows on the hide buttons, check
the Arrows on Hide Buttons box (by default, this box will be checked when you select Show
Hide Buttons. To make the taskbar disappear, select Autohide. The task bar will reappear
when you place the cursor on the side of the screen where the panel was before it hid. The
Background tab in Panel Properties allows you to use the system theme (default setting),
or select a color of your choosing. You can also set the transparency of the panels, or even
select a picture or design from your files as a panel background.

Changing the desktop background is quite simple. You can either right-click on the desk-
top and select Change Desktop Background from the pop-up menu, or, from the top panel,
select the System menu, Preferences, Appearance. When the Appearance Preferences window
opens up, click on the Background tab. You will see some stock backgrounds to choose from.
If you are looking for something beyond these, you can use any picture on your computer
as a desktop background. Click the button labelled “Add...” and find the picture you wish
to use. Double-click on it, and the change will take effect immediately. Once you do this,
the picture will become available in the Appearance Preferences. To find even more great
desktop backgrounds, click on the “Get More Backgrounds Online” link at the bottom of the
Appearance Preferences window. This link will open your web browser, and direct you to the
GNOMElook.org website.

You can also change the fonts through the Appearance Preferences window. Just click on
the Fonts tab. You can individually set the font style and size for applications, documents,
desktop items, window titles, and for anything using fixed width fonts. The Rendering section
at the bottom of the Fonts window gives you four options for font rendering.

Windows

The Appearance Preferences window has a Theme tab, where you can select a theme that will
control the appearance of your windows, buttons, scroll bars, panels, icons, and other parts of
the desktop. Ubuntu comes with nine themes to choose from, and the Human theme is selected
by default. You can download additional themes by clicking the “Get More Themes Online”
link on the bottom of the Themes window. The link will take you to the GNOMElook.org
website, where you can download from a large selection of themes. To add downloaded themes

You can also choose to delete
the panels, and install a Mac
OS X-style dock. Two dock
programs available in the
Ubuntu Software Center are
Cairo-Dock and Avant
Window Navigator (AWN).
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to the Themes tab, drop-and-drag the downloaded file into the Themes window (this will work
for most themes). You can customize any theme: select the theme, and click the Customize
button. This will allow you to mix elements of different themes, thus creating your own
special theme.

Screensaver

Ubuntu offers a selection of screensavers. By default, Ubuntu goes to a black screen after a
period of inactivity. To select a different screensaver, click on the System menu on the top
panel, select Preferences, and select Screensaver. This will open the Screensaver Preferences
window. The available screensavers are listed on the left side of the window. When you
select a screensaver, you will see a mini-preview in the window. To see how it will look on
your screen, click the Preview button. To exit the preview, click the Leave Fullscreen button
on the top of the screen. The left and right arrow buttons in Fullscreen allow you to scroll
through the available screensavers while still in full screen mode. Make sure that the Activate
Screensaver When Idle box is checked to activate the screensaver. The slider can be adjusted
to set the idle time. For added security, you can check the Lock Screen When Screensaver Is
Active box. This will require your login password to return to using the computer.

Accessibility

Ubuntu has built-in tools that make using the computer easier for people with certain phy-
sical limitations. These tools can be found by clicking on the System menu, then choosing
Preferences, then Assistive Technologies. In addition to the Assistive Technologies,
certain appearance tweaks, such as selecting high contrast themes and larger on-screen fonts
can assist those with limited vision. You can also adjust keyboard and mouse settings through
the Assistive Technologies window. Just click on the Keyboard Accessibilty or Mouse Acces-
sibility buttons in the Preferences section to access those features.

Assistive Technoligies

Orca, a tool for persons with visual impairments, is pre-installed on Ubuntu. To run Or-
ca, Press ALT+F2, type Orca in the command box, and click on the Run button. You
can also run Orca from the command line. To do this, open a Terminal (Applications>
Accessories> Terminal), type Orca at the prompt and press Enter. Orca’s voice syn-
thesizer will activate to navigate you through the various voice options, Braille, and screen
magnification. Once you have selected all settings, log out of the computer. Once you log back
in, the Orca settings you chose will automatically run every time you use your computer.

Shutting Down Your Computer

When you’re done working on your computer, you can shut down the computer or place it
in standby through the Session Indicator applet on the far right end of the top panel. You
can also access these options by pressing the CTRL4+ALT+DELETE keys.
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Logging Out

To log out and leave the computer running, select Log Out from the Session Indicator menu.
Rebooting

To reboot your computer, select Restart from the Session Indicator menu.

Shut Down

To totally power down your computer, select Shut Down from the Session Indicator menu.

Other Options

From the Session Indicator menu, you can also choose to Lock Screen (good if you need to
leave your computer for a few minutes), set up a Guest Session for a friend to try Ubuntu,
or Switch User to use another user account without closing your running applications.



3 Standardanwendungen

Internetverbindung herstellen

Bevor Sie das Optimum aus Threm Rechner herausholen kénnen, stellen Sie sicher, dass Sie
iber eine Internetverbindung verfiigen. Dieser Abschnitt des Handbuches wird Thnen dabei
helfen, Thre Internetverbindung zu kontrollieren und herzustellen.

Ubuntu kann sich per Kabel, WLAN oder Einwahlverbindung mit dem Internet verbin-
den. Es unterstiitzt aber noch weitere Verbindungsoptionen.

Eine Kabel-Verbindung wird verwendet, wenn der Rechner physisch per Kabel mit einem
Router oder Netzwerkport verbunden ist. Das ist die am weitesten verbreitete Verbindungs-
methode bei Desktoprechnern.

Eine WLAN-Verbindung wird verwendet, wenn der Rechner per Funkverbindung mit
dem Internet verbunden ist, auch als Wi-Fi bekannt. Haufig werden Laptoprechner per Funkt
verbunden, besonders wenn Sie im mobilen Einsatz sind. Um eine Funkverbindung herstellen
zu konnen, missen Sie ein WLAN-Netz aufgebaut haben. Das ist normalerweise der Fall,
wenn Sie einen WLAN-Router oder Accesspoint gekauft und eingerichtet haben, oder
wenn Sie sich an einem Ort aufhalten, an welchem ein WLAN-Netz aufgebaut wurde.

Eine Einwahl-Verbindung liegt vor, wenn sich Thr Rechner mit einem Modem und einem
Telefonkabel mit dem Internetprovider verbindet.

Ubuntu kann ebenso eine Verbindung {iber mobiles Breitband, VPN oder DSL herstellen.

Netwzerk-Manager

Um mit Ubuntu eine Verbindung zum Internet herzustellen, miissen Sie die Anwendung
NetworkManager verwenden. NetworkManager erlaubt es ihnen, Thr Netzwerk an- und
auszuschalten und Ihre Kabel-, Funk- und andere Verbindungen zu verwalten.

Sie konnen alle Funktionen des NetworkManagers verwenden, indem Sie sein Symbol in
dem oberen Panel benutzen. Das Symbol sieht anders aus, je nachdem ob Sie bereits eine
Verbindung haben und Ihre Verbindung kabelgebunden oder per Funk lduft. Wenn Sie Thren
Mauszeiger uiber das Symbol bewegen, sollte es “Kabelverbindung ...”, “Keine Verbindung”
oder “Netzwerk deaktiviert” oder etwas dhnliches netzwerkbezogenes anzeigen.

Wenn Sie momentan mit dem Internet verbunden sind, kénnen Sie auf das Symbol kli-
cken. Daraufhin erscheint eine Liste an verfiigharen Netzwerken, bei denen Thre momentane
Verbindung fett hervorgehoben ist.

Sie konnen auch rechts auf das NetworkManager-Symbol klicken. Darauthin erscheint ein
Menii, in welchem Sie das Netzwerk (de-)aktivieren, technische Details anzeigen oder Thre
Verbindungseinstellungen verwalten konnen. In der Grafik ist die Auswahlbox fiir “Netzwerk

Dieses Handbuch deckt nur
die Einrichtung einer
Internetverbindung ab,
wéhrend die Verbindung zu
einem Firmen- oder anderem
Netzwerk dhnlich ist.

Note: VPN bedeutet
“Virtuelles Privates
Netzwerk”, und wird
manchmal fiir sichere
Verbindungen verwendet.
DSL bedeutet “Digital
Subscriber Lines”, ein Typ
von Breitbandverbindung.
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aktivieren” ausgewéhlt; Sie konnen Sie abwéihlen, um alle Netzwerkverbindungen zu deakti-
vieren. Das kann niitzlich sein, wenn Sie alle Funkverbindungen deaktivieren miissen, zum
Beispiel in einem Flugzeug.

Eine Verbindung herstellen

Um online zu gehen, miissen Sie sicherstellen, dass Sie eine Verbindung aufgebaut haben. Es
gibt viele verschiedene Wege, Ubuntu mit dem Internet zu verbinden — einige davon werden
wir im Folgenden besprechen.

Kabelgebunden

Wenn Sie ein Netzwerkkabel haben, dass von einer Wanddose, einem Router oder einem
anderen Gerat zu Ihrem Rechner verlduft, miissen Sie wahrscheinlich eine kabelgebundene
Netzwerkverbindung benutzen. Das ist der h&ufigste Fall fiir Desktoprechner und andere
stationdre, mit dem Internet verbundene Rechner.

Um eine kabelgebundene Verbindung herzustellen, benétigen Sie die Information, ob IThre
Netzwerkverbindung DHCP unterstiitzt. Das steht fiir “Dynamic Host Configuration Pro-
tocol” und ist eine Méglichkeit fiir Rechner in Threm Netzwerk, automatisch eine IP-Adresse
samt zugehoriger Konfiguration zu beziehen. Wenn Sie dariiber unsicher sind, versuchen Sie
zuerst DHCP zu verwenden. Wenn das nicht funktioniert, fragen Sie Thren Netzwerkadmi-
nistrator nach statischen IP-Adressinformationen.

Automatische Verbindung mit DCHP

Wenn Thr Netzwerk DHCP unterstiitzt, sind Sie vielleicht schon online. Um zu kontrollieren,
ob Sie online sind, klicken Sie rechts auf das NetworkManager-Symbol im oberen Panel und
wahlen Sie die Verbindungsinformationen-Option.

Sie sollten ein Fenster sehen, dass Ihnen Details iiber Thre Verbindung zeigt. Wenn Ih-
re IP-Adresse 0.0.0.0 ist, oder mit 169.254 beginnt, haben Sie keine giiltige Adresse iiber
DHCP zugewiesen bekommen. Wenn hier etwas anderes steht, ist es wahrscheinlich, dass
Ihre Verbindung richtig eingerichtet wurde.

Wenn Sie das Verbindungsinformationen-Fenster nicht anzeigen lassen kénnen, weil die
Option im NetworkManager ausgegraut ist, ist Thre Verbindung nicht aktiv. Um zu iiberpri-
fen, ob Thre Verbindung aktiv ist, stellen Sie sicher, dass Netzwerk aktivieren ausgewéhlt
ist.

Klicken Sie dann mit der linken Maustaste auf das NetworkManager-Symbol. Dort sollte
ein Eintrag fiir “Kabelnetzwerk” in dem erscheinenden Menii angezeigt werden. Wenn diese
Option ein ausgegrautes “nicht verbunden” zeigt, finden Sie die Option “Auto eth0” in der
Liste und klicken Sie links, um zu versuchen, eine Verbindung herzustellen. Wenn “Auto
eth0” direkt unter “Kabelgebunden” steht, ist Thr Rechner korrekt fiir DHCP eingerichtet.

Wenn Sie nach diesen Schritten immer noch nicht online sind, sollten Sie die Einstellungen
mit Threm Netzwerkadministrator nochmal iiberpriifen und méglicherweise mit der Anleitung
zum manuellen Einrichten einer statischen IP-Adresse fortfahren.

Note: Sind Sie bereits
online? Wenn das Symbol
des Netzwerkmanagers im
Panel eine Verbindung
anzeigt, haben Sie wahrend
dem Installationsprozess
wahrscheinlich schon eine
erfolgreiche Verbindung mit
dem Internet hergestellt.
Wenn das der Fall ist,
iberspringen Sie den Rest
des Abschnittes.
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Manuelle Konfiguration mit statischer Adresse

Wenn Thr Netzwerk DHCP nicht unterstiitzt, sollten Sie einige Dinge wissen, bevor Sie online
gehen konnen.

s IP-Adresse — Dies wird die Adresse Ihres Rechners sein. Diese hat immer die Form von
vier durch Dezimalpunkte getrennten Zahlen, zum Beispiel 192.168.0.2

= Netzwerkmaske — Diese informiert IThren Rechner dartiber, wie grof3 IThr Netzwerk ist.
Sie sieht normalerweise genauso aus wie eine IP-Adresse, normalerweise in der Gegend
von 255.255.255.0

= Gateway — Das ist die IP-Adresse des Routers Thres Netzwerkes: Thr Rechner sendet
die Daten, die ans Internet gesandt werden sollen, dorthin.

= DNS-Server — Eine oder mehrere IP-Adressen von “Domain Name System”-Servern,
welche Namen wie www.ubuntu.com in IP-Adressen wie 91.189.94.156 umwandeln; Ein
Server wird benotigt, weitere sind optional, fiir den Fall das der erste ausfillt.

Wenn Sie diese Daten nicht haben, miissen Sie Thren Netzwerkadministrator danach fra-
gen.

Um eine kabelgebundene Netzwerkverbindung manuell zu konfigurieren, klicken Sie rechts
auf das NetworkManger-Symbol und wéhlen Sie Verbindungen bearbeiten. Stellen Sie si-
cher, dass Sie den “Kabelgebunden”-Reiter im angezeigten “Netzwerkverbindungen”-Fenster
ausgewdhlt haben.

Diese Liste kann bereits einen Eintrag enthalten, wie zum Beispiel “Auto eth0” oder
anderen, dhnlichen Namen. Wenn eine Verbindung aufgelistet ist, klicken Sie auf diese und
driicken Sie den Bearbeiten-Knopf. Wenn keine Verbindung angezeigt wird, driicken Sie
stattdessen den Knopf Hinzufiigen.

Wenn Sie eine neue Verbindung hinzufiigen, miissen Sie zuerst einen Namen angeben.
Geben Sie diesen bitte in das Feld “Verbindungsname” ein, zum Beispiel “Kabelgebundene
Verbindung 1”.

Um die Verbindung einzurichten:

1. Stellen Sie sicher, dass das Auswahlfeld Automatisch verbinden unter dem Verbin-
dungsnamen ausgewdhlt ist.

2. Wechseln Sie zum Reiter IPv4-Einstellungen
Andern Sie die Methode auf “Manuell”

- W

Klicken Sie auf den Knopf Hinzufiigen neben der leeren Adressliste

5. Geben Sie Thre IP-Adresse in das Feld unter der Uberschrift IP-Adresse ein
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6. Klicken Sie mit der linken Maustaste rechts neben die IP-Adresse, direkt unter die Netz-
werkmaske-Uberschrift und geben Sie Ihre Netzwerkmaske ein

7. Klicken Sie rechts neben die Netzwerkmaske, direkt unter die Gateway-Uberschrift und
geben Sie Thre Gatewayadresse ein

8. In das unten liegende DNS-Server-Feld geben Sie die per Leerzeichen oder Kommata
getrennten DNS-Serveradressen ein

9. Klicken Sie auf die Anwenden Schaltfliche und speichern Sie die Anderungen.

@ ——p
@ -

In manchen Fallen missen Sie noch eine MAC-Adresse angeben. Diese wird im Reiter
“Kabelgebunden” angegeben. Die MAC-Adresse ist die Hardwareadresse Ihrer Netzwerkkarte
und wird manchmal fir Kabelmodems und dhnliche Verbindungen bendtigt.

Wenn Sie wieder auf dem “Netzwerkverbindungen”-Schirm sind, sollte Thre neu angelegte
Verbindung gelistet sein. Klicken Sie auf die Schaltfliche Schlieflen, um zur Arbeitsfliche
zuriickzukehren. Wenn Sie Thre Netzwerkverbindung korrekt eingerichtet haben, sollte das
NetworkManager-Symbol eine aktive Verbindung anzeigen. Verwenden Sie die Anweisungen
aus dem Abschnitt DHCD, um zu priifen, ob Thre Verbindung korrekt eingerichtet wurde.

Der abschlielende Test Threr Netzwerkverbindung steht an, wenn Sie versuchen, einen
Webbrowser zu benutzen, wie spéter in diesem Kapitel erklart wird.

Funknetzwerk

Wenn Thr Rechner mit einer WLAN-(Wi-Fi)-Karte ausgestattet ist und Sie ein Funknetz-
werk in Threr Ndhe haben, sollten Sie in der Lage sein, eine WLAN-Verbindung mit Ubuntu
herstellen zu kénnen.

Eine WLAN-Verbindung zum ersten Mal herstellen

Wenn Thr Rechner eine WLAN-Karte besitzt, sollten Sie sich mit einem Funknetzwerk ver-
binden kénnen. Die meisten Laptops und Netbooks besitzen eine WLAN-Karte.

Ubuntu erkennt verfiigbare Netzwerke normalerweise automatisch. Um eine Liste verfiig-
barer Netzwerke einzusehen, klicken Sie auf das NetworkManager-Symbol. Unter der Uber-
schrift “Funknetzwerk” sollten Sie eine Liste verfiigbarer Netzwerke sehen. Jedes Netzwerk
wird mit dem Namen links und der Signalstirke rechts angezeigt. Die Signalstidrke wird
iiber eine Reihe an Balken dargestellt — Je mehr Balken gefiillt sind, desto besser ist die
Verbindung, die Thr Rechner zu dem Netzwerk aufbauen kann.

Die Verbindung zu einem Funknetzwerk kann fiir jeden offen oder mit Sicherheitssperren
geschiitzt sein. Die Liste der verfiigbaren Netzwerke kann ein kleines “Schloss”-Symbol neben
der Signalstirke enthalten. Das bedeutet, dass Sie das richtige Passwort bendtigen um sich
mit dem gesicherten Funknetzwerk zu verbinden.
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Um sich mit einem Funknetzwerk zu verbinden, klicken Sie auf den Namen des Netzwerkes
in der Liste. Sie sollten wissen, mit welchem Netzwerk Sie sich verbinden moéchten — Es
sollte das sein, welches Sie eingerichtet haben, als Sie Thren WLAN-Router oder -Accesspoint
installiert haben. Wenn Sie in einem Unternehmen oder eine Bildungseinrichtung sind, wird
der Name des Netzwerkes wahrscheinlich dem der Einrichtung &hnlich sein.

Wenn das Netzwerk offen ist (also kein Schloss neben der Signalstirke angezeigt wird),
sollte eine Verbindung innerhalb von Sekunden verfiigbar sein. Das NetworkManager-Symbol
in der Taskleiste zeigt eine Animation an, wihren Ubuntu versucht sich mit dem Netzwerk zu
verbinden und sollte zu den Signalstirke-Balken werden, sobald die Verbindung hergestellt
wurde.

Ubuntu wird in der rechten oberen Ecke auch eine Nachricht anzeigen, welche Sie dariiber
informiert, dass die Verbindung hergestellt wurde.

Wenn das Netzwerk gesichert ist, wird Ubuntu Ihnen ein Fenster namens “Legitimierung
fiir Funknetzwerk bendtigt” anzeigen. Dieses Fenster bedeutet, dass das Funknetzwerk ein
Passwort benétigt um die Verbindung zuzulassen.

Wenn Sie das Passwort wissen, geben Sie es in das Feld Passwort ein und driicken Sie
die Verbinden Schaltfliche. Das Passwort wird wihrend der Eingabe verschleiert, um zu
Verhindern, dass man das Passwort vom Bildschirm mitlesen kann. Wenn Sie das eingege-
bene Passwort lieber noch einmal kontrollieren méchten, driicken Sie die Passwort zeigen
Schaltfliche, nachdem Sie Thr Passwort eingegeben haben.

Nachdem Sie die Verbinden Schaltfliche gedriickt haben, zeigt das NetworkManager-
Symbol in der oberen Taskleiste eine Animation an, wihrend es versucht, eine Verbindung
zu dem Netzwerk aufzubauen. Wenn Sie das Passwort richtig eingegeben haben, sollte das
NetworkManager-Symbol die Signalstidrke-Balken zeigen, sobald eine Verbindung aufgebaut
wurde.

Genauso wie bei ungesicherten Netzwerken zeigt Ubuntu eine Nachricht in der rechten
oberen Ecke IThres Bildschirms an, um Sie dariiber zu informieren, dass eine Verbindung
aufgebaut wurde.

Wenn Sie nicht das richtige Passwort eingegeben haben, wird das NetworkManager-
Symbol trotzdem eine Animation anzeigen und Ihnen wahrscheinlich wieder das Fenster
“Legitimierung fiir Funknetzwerk benotigt” anzeigen. Sie kdnnen jetzt entweder das richtige
Passwort angeben, oder die Schaltfliche Abbrechen driicken, um den Verbindungsaufbau
zu unterbrechen. Wenn Sie das Passwort fiir das Netzwerk nicht kennen, miissen Sie es bei
Threm Netzwerkadministrator erfragen.

Sobald Sie erfolgreich eine Netzwerkverbindung aufgebaut haben, wird Ubuntu diese fiir
Sie speichern. Das macht es einfacher fiir Sie, sich in der Zukunft mit dem selben Netzwerk
wiederzuverbinden.

Verbindung zu einem bekannten Funknetzwerk herstellen

Wenn Sie in der Vergangenheit bereits erfolgreich eine Verbindung zu einem Funknetzwerk
hergestellt hatten, wird das Passwort dieser Verbindung auf Threm Rechner gespeichert. Das
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erlaubt es Thnen, sich mit diesem Netzwerk wiederzuverbinden, ohne das Passwort erneut
eingeben zu miissen.

Zusatzlich wird Ubuntu automatisch versuchen, sich mit bekannten Funknetzwerken in
der Umgebung zu verbinden. Das funktioniert sowohl fiir gesicherte wie ungesicherte Funk-
netzwerke.

Wenn Sie mehrere bekannte Funknetzwerke in Reichweite haben, wird Ubuntu sich mit
irgendeinem davon verbinden, obwohl Sie gerne ein anderes hétten. In diesem Fall klicken
Sie auf das NetworkManager-Symbol, um eine Liste von Funknetzwerken in Reichweite und
deren Signalstérke zu erhalten. Klicken Sie auf das gewiinschte Netzwerk.

Wenn das Passwort und andere Einstellungen nicht gedndert wurden, wird Ubuntu sich
mit dem gewédhlten Netzwerk verbinden. Wenn sich das Passwort gedndert hat, wird Ubuntu
das Fenster “Legitimierung fiir Funknetzwerk benttigt” 6ffnen. In diesem Fall folgen Sie den
Anweisungen aus dem vorherigen Abschnitt.

Verbindung zu einem verborgenem Funknetzwerk herstellen

Unter manchem Umsténden miissen Sie sich mit einem verborgenem Funknetzwerk verbin-
den. Diese verborgenen Funknetzwerke geben Thre Namen nicht kund — Was bedeutet, dass
sie nicht in der Liste verfiigharer Funknetzwerke im NetworkManager-Menii auftauchen. Um
sich mit einem verborgenem Netzwerk zu verbinden, fragen Sie Ihren Netzwerkadministrator
nach seinem Namen und den Sicherheitseinstellungen.

Verbindung zu einem verborgenem Netzwerk herstellen:

1. Klicken Sie auf das NetworkManager-Symbol im oberen Panel

2. Wahlen Sie die Option Mit einem verborgenem Funknetzwerk verbinden .... Ubu-
ntu sollte eine Fenster namens “Mit einem verborgenen Funknetzwerk verbinden” 6ffnen.

3. Das Feld Verbindung sollte “Neu ...” zeigen — Sie konnen das so iibernehmen

4. In dem Feld Netzwerkname geben Sie den Namen des Funknetzwerkes ein. Der Name
ist auch als “SSID” bekannt. Bitte geben Sie den Namen genau so ein, wie er Thnen
mitgeteilt wurde

5. In dem Feld Sicherheit des Funknetzwerks wihlen Sie die entsprechende Option.
Wenn das Netzwerk ungesichert ist, lassen Sie das Feld auf “Keine”. Wenn Sie die pas-
senden Einstellungen fiir das Netzwerk nicht kennen, kénnen Sie sich nicht mit dem
verborgenen Netzwerk verbinden

6. Klicken Sie auf die Verbinden Schaltfldche
Der Rest des Vorganges sollte genauso ablaufen wie in dem Abschnitt iiber die Einrichtung

eines Funknetzwerks beschrieben. Das Netzwerk sollte in der Liste der bekannten Netzwerke
auftauchen, sobald es entsprechend den obigen Anweisungen eingerichtet wurde.
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lhre WLAN-Karte aktivieren und deaktivieren

Wenn Thr Rechner eine WLAN-Karte besitzt, ist die Funknetzwerkverbindung in Ubuntu
automatisch aktiviert. In manchen Féllen, zum Beispiel in einem Flugzeug, kann es sein dass
Sie die Verbindung deaktivieren méchten oder miissen.

Um das zu bewerkstelligen, klicken Sie rechts auf das NetworkManager-Symbol und wéh-
len Sie die Option Funknetzwerk aktivieren ab. Thre WLAN-Karte wird deaktiviert und
Thr Rechner wird nicht weiter nach verfiigbaren Funknetzwerken suchen.

Um Thre WLAN-Karte wieder zu aktivieren, klicken Sie rechts auf das NetworkManager-
Symbol und wéhlen Sie die Option Funknetzwerk aktivieren wieder an. Thre WLAN-
Karte wird wieder aktiviert. Ubuntu wird wieder nach verfiigharen Funknetzwerken in der
Umgebung suchen und sich zu bekannten Netzwerken verbinden.

Eine bestehende Funknetzwerkverbindung bearbeiten

Manchmal kann es vorkommen, dass Sie die gespeicherten Einstellungen fiir eine Funknetz-
werkverbindung, die Sie in der Vergangenheit gespeichert hatten, &ndern méchten. Das Pass-
wort kann sich gedndert haben, oder Thr Netzwerkadministrator hat gewisse Netzwerk- oder
Sicherheitseinstellungen geédndert.

Um eine gespeicherte Funknetzwerkverbindung zu dndern:

1. Klicken Sie rechts auf das NetworkManager-Symbol und wéhlen Sie Verbindungen be-
arbeiten...

2. FEin Fenster namens “Netzwerkverbindungen” sollte sich 6ffnen. Klicken Sie auf den Funk-
netzwerk-Reiter um eine Liste gespeicherter Funknetzwerkverbindungen zu erhalten

3. Diese Liste zeigt die Verbindungen in der Reihenfolge ihrer letzten Benutzung an. Suchen
Sie die Verbindung, die Sie bearbeiten moéchten und klicken Sie auf die Bearbeiten
Schaltflache

”

4. Ubuntu sollte jetzt ein Fenster namens “ Verbindungsname bearbeiten ” 6ffnen, wobei
Verbindungsname der Name der zu bearbeitenden Verbindung ist. Das Fenster sollte eine
gewisse Anzahl an Reitern enthalten.

5. Sie kénnen den Eintrag in dem Feld Verbindungsname iiber den Reitern &ndern, wenn
Sie der Verbindung einen aussagekriftigeren Namen geben mochten

6. Wenn die Option Automatisch verbinden abgewé&hlt ist, wird Ubuntu sich nicht au-
tomatisch zu dem Funknetzwerk verbinden, solange Sie das Netzwerk nicht explizit im
NetworkManager-Menii auswéhlen, selbst wenn es in Reichweite ist. Setzen Sie die Option
je nach Bedirfnis.

7. In dem Reiter Funknetzwerk des Fensters “ Verbindungsname bearbeiten ” kénnen Sie
auch das Feld SSID bearbeiten. Die “SSID‘ ist der Netzwerkname der Verbindung —
Wenn sie falsch ist, wird das Netzwerk nicht erkannt und keine Verbindung aufgebaut.
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Stellen Sie sicher, dass die SSID entsprechend den Anweisungen Ihres Netzwerkadminis-
trators gesetzt ist.

8. Unter der SSID befindet sich das Feld Modus. Der “Infrastruktur”’-Modus bedeutet,
dass Sie sich zu einen WLAN-Router oder -AccessPoint verbinden. Das ist der gebrauch-
lichste Modus fiir Funknetzwerke. Der Modus “Ad-Hoc” ist fiir Rechner-zu-Rechner-
Verbindungen und wird héufig in fortgeschrittenen Szenarien verwendet.

9. In dem Reiter Sicherheit des Funknetzwerks des Fensters “emphVerbindungsname
bearbeiten” kénnen Sie in dem Feld Sicherheit die richtigen Einstellungen tétigen. Die
Auswahl Keine bedeutet, dass Sie ein ungesichertes Netzwerk ohne jegliche Verschliisse-
lung verwenden. Andere Auswahlen benotigen leicht unterschiedliche Informationen:

= WEP 64/128-bit-Schliissel ist eine éltere Sicherheitseinstellung, welche noch in ei-
nigen &lteren Funknetzwerken verwendet wird. Wenn Ihr Netzwerk diesen Verschliisse-
lungsmodus benutzt, miissen Sie einen Schliissel in das Feld Schliissel eingeben, dass
erscheint nachdem Sie diesen Modus ausgewéhlt haben. Der Schliissel wird normaler-
weise als Reihe von alphanumerischen Zeichen von 0 bis 9 und A bis F angegeben.

= WEP 128-bit Kennwort ist die gleiche altere Sicherheitseinstellung wie der obige
Eintrag. Allerdings miissen Sie eine Passphrase — ein Passwort — an Stelle eines
Schliissels angeben, welches Thr Netzwerkadministrator IThnen mitgeteilt haben sollte.
Sobald Sie diesen Sicherheitsmodus ausgewéhlt haben, miissen Sie die Passphrase in
das Feld Schliissel eingeben.

= WPA & WPA2 Personal ist der am Weitesten verbreitetste Sicherheitsmodus fiir
Funknetzwerke daheim oder in Firmen. Sobald Sie diesen Modus ausgewéhlt haben,
miissen Sie ein Passwort in das Passwort Feld eingeben.

= Wenn Thr Netzwerk LEAP, Dynamisches WEP, oder WPA & WPA2 Enterprise be-
notigt, fragen Sie Thren Administrator um Hilfe, um diese Sicherheitsmodi korrekt
einzurichten.

10. On the IPv4 Settings tab, you may need to change the Method field from “Automatic
(DHCP)” to “Manual”, or one of the other methods. For setting up manual settings
(also known as static addresses), please see the section above on manual set up for wired
network connections.

11. Wenn Sie Thre Anderungen vollzogen haben, klicken Sie die Schaltfliche Anwenden
um sie zu speichern und das Fenster zu schlieffen. Sie kénnen die Cancel Schaltfliche
driicken, um das Fenster zu schlieBen ohne die Anderungen zu speichern.

12. Klicken Sie abschlielend auf die Schlief3en Schaltfliche in dem “Netzwerkverbindungen”
Fenster um zur Arbeitsfliche zuriickzukehren.

Nachdem Sie die Anderungen gespeichert haben, sollten diese sofort angewendet werden.
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Fehleranalyse haufig auftretender Funknetzwerkverbindungsprobleme
Einwahl

Andere Verbindungsmethoden

Es gibt noch andere Moglichkeiten, mit Ubuntu Netzwerkverbindungen aufzubauen.

Mit dem NetworkManager kénnen Sie auch mobile Breitbandverbindungen iiber Handys
oder andere mobile Geréte herstellen.

Sie konnen sich auch per DSL (Digital Subscriber Line) verbinden, eine Verbindungsme-
thode welche Ihre Telefonleitung und ein “DSL-Modem” verwendet.

Sie konnen mit dem NetworkManager auch eine VPN (Virtuelles Privates Netzwerk)-
Verbindung herstellen. Diese werden normalerweise verwendet, um sichere Verbindung zu
seinem Arbeitsplatz herzustellen.

Browsing the web

Once you have connected to the internet, you should be able to browse the web with Ubuntu.
The Mozilla Firefox is the default application for browsing the web in Ubuntu.

Starting Firefox
To start Firefox, click on the Applications menu, then Internet, and select Firefox Web
Browser.

If your keyboard has a “WWW?” button, you can also press that button to start Firefox.
Navigating web pages
Viewing your homepage
When you start Firefox, you will see your home page. By default, you will see the Ubuntu

Start Page.

To display more web content on the screen, you can use Full Screen mode. Full Screen
mode condenses the Firefox’s toolbars into one small toolbar. To enable Full Screen mode,
simply select View > Full Screen or press F11.

To go to your home page quickly, press Alt+Home.
Navigating to another page

To navigate to a new web page, you need to type its internet address (also known as a URL)
into the Location Bar. URLs normally begin with “http://” followed by one or more names
that identify the address. One example is “http://www.ubuntu.com/”.

To navigate:
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1. Click the Location Bar to select the URL that is already there.

2. Type the URL of the page you want to visit. The URL you type replaces any text already
in the Location Bar.

3. Press Enter.

To quickly select the URL of the Location Bar, press Ctrl+L.

If you don’t know a URL, try typing something specific to the page you want to visit (for
example a name or other search request) into the Location Bar and press Enter. This will
search your preferred search engine — Google by default — for that term, and take you to
the web page that is the top result from the search.

Clicking a link

Most web pages contain links you can click to move to other pages.

To click a link:

1. Move the mouse pointer until it changes to a pointing finger. This happens whenever the
pointer is over a link. Most links are underlined text, but buttons and pictures on a web
page can also be links.

2. Click the link once. While Firefox locates the link’s page, status messages will appear at
the bottom of the window.
Retracing your steps

If you want to visit a page you have seen before, there are several ways to do so.

= To go back or forward one page, click the Back or Forward button.

= To go back or forward more than one page, click the small triangles on the Back and
Forward buttons. You should see a list of pages you’ve recently visited. To return to a
page, select it from the list.

= To see a list of any URLs you’ve typed into the Location Bar, click the down arrow at
the right end of the Location Bar. To view a page, select it from the list.

= To choose from pages you've visited during the current session, open the History menu
and use the list in the bottom section of the menu.

= To choose from pages you’ve visited during the past several sessions, open the History
menu and select Show All History. Firefox should open a “Library” window, which
should a list of folders. Click the folders to displays subfolders, or titles of web pages
you’ve visited in the past. Click a page’s title to view that page.
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Stopping and reloading

If a page is loading too slowly or you no longer wish to view a page, click the Stop button.
To reload the current page or to get the most up-to-date version, click the Reload button

or press Ctrl+R.

Opening new windows

At times, you may want to have more than one browsing windows. This may help you organize

your browsing session better, or separate web pages that you are viewing for different reasons.

There are two ways to create a new window:

= On the menubar, click the File menu, then select New Window

= Press Ctrl-N

Once a new window has opened, you can use it just like the first window — including
navigation and opening tabs.

Opening a link in a new window

Sometimes, you may want to click a link to navigate to another web page, but do not want
the original page to close. To do this, you can open the link you’d like to click in its own
window.

There are two ways to open a link in its own window:

= Right-click on a link to bring up its popup menu. Select the Open Link in New Window
option. A new window should open, containing the web page for the link you clicked.

= Hold down the Shift key while clicking the link. A new window should open, containing
the web page for the link you clicked.

Tabbed browsing

If you would like to visit more than one web page at a time, you can use “Tabbed Browsing”
to navigate the web.

Tabbed browsing lets you open several web pages within a single Firefox window, each
displaying in its own tab. This frees up space on your desktop since you don’t have to have
a window open for every web page you’re currently visiting. You can open, close, and reload
web pages in one place without having to switch to another window.
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Opening a new blank tab

There are three ways to create a new blank tab:

= Click the New Tab button on the right side of the last tab.
= On the menubar, click the File menu, and then select New Tab.
= Press Ctrl+T.
When you create a new tab, it will contain a blank page with the Location bar focused.
Start typing a web address (URL) or other search term to open a website in the new tab.
Opening a link in its own tab

Sometimes, you may want to click on a link to navigate to another web page, but do not
want the original page to close. To do this, you can open the link you’d like to click in its
own tab.

There are three ways to open a link in its own tab:
= If your mouse has a middle button, or a wheel, click on the link with the middle mouse
button or wheel. A new tab should open, containing the web page for the link you clicked.

= Click on the link with the left mouse button, and keep holding down the mouse button.
Drag the link up to a blank space on the tab bar, and release the mouse button. A new
tab should open, containing the web page for the link you dragged.

= Hold down the Ctrl key while clicking the left mouse button on the link. A new tab
should oepn, containing the web page for the link you clicked.
Closing a tab

Once you are done viewing a web page in a tab, you can close that tab.

There are three ways to close a tab:

Click on the Close button on the right side of the tab you want to close.

On the menubar, click the File menu, and then select Close Tab.

Click on the tab you want to close with the middle mouse button, or the mouse wheel, if
you have one.

Press Ctrl+w
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Restoring a closed tab
Sometimes, you have closed the wrong tab by accident, or for another reason would want to
bring back a tab that you’'ve recently closed.

To bring back a tab you've closed:

= On the menubar, click the History menu, select Recently Closed Tabs, and then select
the tab you want to restore.

= Press Ctrl+Shift+T to re-open the most recently closed tab.
Changing the tab order

To move a tab to a different location on the tab bar, drag it there using your mouse. Click on
the tab with your left mouse button and hold the mouse button as you drag the tab to a new
place on the tab bar. While you are dragging the tab, Firefox will display a small indicator
to show where the tab will be moved.

Moving a tab between windows

If you have more than one Firefox window open, you can move an open tab to a different
window. It is also possible to have a tab split off and become its own window.

To move a tab from one Firefox window to another already open window, click on the
tab with your left mouse button, hold down the left mouse button, and then drag it to the
tab bar on the other Firefox window. When you release the mouse button, the tab will be
attached to the new window.

To move a tab from one window into its own window, click on the tab with your left
mouse button, hold down the left mouse button, and then drag the tab below the tab bar.
When you release the mouse button, the tab will become a new window.

Searching

You can search the web, or other collections, from within Firefox without first visiting the
home page of the search engine.

By default, Firefox will search the web using the Google search engine.
Searching the web

To search the web in Firefox, type a few words into the Firefox Search Bar.

For example, if you want to find information about the world cup:

1. Click in the Search Bar.
2. Type the phrase “world cup”. Your typing replaces any text currently in the Search Bar.

3. Hit Enter to search.

Search results from Google for “world cup” should appear in the Firefox window.
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Selecting search engines
If you do not want to use Google as your search engine in the Search Bar, you can change
the search engine that Firefox uses.

To change the search engine, click the icon on the left side of the Search Bar. Select one
of the other search engines in the list. Some search engines, like Google, search the whole
web; others, like Amazon.com, only search specific sites.

Searching the web for words selected in a web page

Sometimes, you may want to search for a phrase that appears on a different web page. Instead
of copying and pasting the phrase into the Search Bar, Firefox allows you to search the web
for words you select within a web page.

1. Highlight any words in a web page using your left mouse button

2. Right-click on the text you’'ve highlighted to display a popup menu. Select the option
Search [Search Engine] for “[your selected words]”.

Firefox should open a new tab which should contain search results for your highlighted
words using the currently selected search engine.

Searching within a page

You may want to look for specific text within a web page you are viewing. To find text within
the page you are currently viewing in Firefox:

1. Press Ctrl+F or select Edit > Find to open the Find Toolbar at the bottom of Firefox.

2. Type the text you want to find into the Find field in the Find Toolbar. The search
automatically begins as soon as you type something into the field.

3. Once some text has been matched on the web page, you can:

= Click Next to find text in the page that is below the current cursor position
= Click Previous to find text that is above the current cursor position.

= Click the Highlight all button to highlight occurrences of your search words in the
current page.

= Select the Match case field to limit the search to text that has the same capitalization
as your search words.

To find the same word or phrase again, press F3 or select Edit>Find Again from the
menubar.
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Copying, saving, and printing pages

With Firefox, you can copy part of a page so that you can paste it elsewhere, or save the
page or part of a page as a file on your computer.

Copying part of a page

To copy text from a page:

1.
2.

Highlight the text with your mouse.

Select Edit > Copy from the menubar.

You can paste the text into other programs.

To copy a link (URL) or an image link from a page:

. Position the pointer over the link or image.

. Right-click on the link or image to display a popup menu.

Choose Copy Link Location or Copy Image Location. If an image is also a link, you
can choose either menu item.

You can paste the link into other programs or into Firefox’s Location Bar.

Saving all or part of a page

To save an entire page in Firefox:

- W

. Select File> Save Page As from the menubar. Firefox should open the “Save As” win-

dow.

. Choose a location for the saved page.

Type a file name for the page, and click the Save button.
To save an image from a page:

Position the mouse pointer over the image.

Right-click on the image to display a popup menu.

Select Save Image As. Firefox should open the “Save Image” window.
Choose a location for the saved image.

Type a file name for the image and click the Save button.
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Changing your homepage

Bu default, Firefox will show the Ubuntu Start Page when you start Firefox. If you prefer
to display another page when you start Firefox, you will need to change your homepage
preference.

To change your homepage:

1. Navigate to the page that you would like to become your new homepage.
2. Select Edit > Preferences from the menubar.

3. In the “Startup” section on the Main tab, which is shown by default, click the Use
Current Pages button. If you had more than one tab open then all the tabs will be
opened when Firefox starts.

4. Click the Close button

Bookmarks

When browsing the web you may want to come back to certain web pages again without
having to remember the URL.

In Firefox, you can create Bookmarks, which are saved in the web browser and which you
can use to navigate back to your picked web pages.
Bookmarking a page
If you have navigated to a web page and would like to bookmark it for future visits, you will
need to add the page as a bookmark.

There are two ways to bookmark a page:

= From the menubar, select Bookmarks and then Bookmark This Page. A window will
open. Provide a descriptive name for the bookmark, and click the Done button.

= Press Ctrl+D. A window will open. Provide a descriptive name for the bookmark, and
click the Done button.

Navigating to a bookmarked page

To navigate to a bookmarked page, select the Bookmarks item from the menubar, and then
click on your bookmark’s name. Firefox should open the bookmark in the current tab.

@ ——p
L

You can also press Ctrl+B to display bookmarks in a sidebar on the left side of the browser
window. Press Ctrl+B again to hide the sidebar
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Deleting a bookmark

If you would like to delete a bookmark that you have previously made, select the Bookmarks
item from the menubar, and then right-click your bookmark’s name. Firefox should open a
popup menu for your bookmark. Select the Delete option from the menu. Your bookmark
should then be deleted.

History

Whenever you are browsing the web, Firefox is saving your browsing history. This allows you
to come back to a web page that you have previously visited without needing to remember
the page’s URL, or even bookmarking it.

To see your most recent history, select the History item from the menubar. The menu
should then display several of the most recent web pages that you were viewing. Click one of
the pages to return to it.

To see history from an older time, press Ctrl+H. Firefox should open a “sidebar” on the
left side of the browser window, which should contain your browsing history categorized as
Today, Yesterday, Last 7 days, This month, and then monthly for the times before that.

Click one of the item categories in the sidebar to expand this category, and see the pages
you’ve visited during that time period. Then, once you find the page you need, click its title
to return to it.

You can also search for a page by its title. Enter a few letters, or a word, in the Search
field at the top of the history sidebar. The sidebar should then display a list of web pages
whose titles match your search words. Click on the title of the page you need to return to it.

If you would like to hide the history sidebar again, press Ctrl+H again.
Clearing private data
Troubleshooting connection problems
Using a different web browser

Reading and composing email

To send and receive email in Ubuntu, you can use the Evolution mail application. To start
Evolution, open the Applications menu, then choose Internet and then Evolution Mail.

In addition to email, Evolution also can help manage your contact list, your calendar,
and a list of tasks.

' You do not need to use Evolution if you are using a webmail system, such as Yahoo Mail,
Hotmail, or Gmail. To access these services, use the Firefox web browser to access them on
the web.
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Running Evolution for the first time

When you start Evolution for the first time, you will need to configure it to connect to your
email account.

When Evolution starts you should see the “Evolution Setup Assistant” window, welcoming
you to Evolution. Click the Forward button to continue with the setup.

Next, on the “Restore from backup” screen, Evolution may ask you to restore from a
previous backup. Since this is the first time you are running Evolution, you can click the
Forward button to skip this step.

On the next screen, “Identity”, you need to enter your name and the email address you
wish to use with Evolution. Enter your full name in the Full Name field, and the full email
address in the Email Address field. You can fill in the optional information, or leave it
unchanged if you desire. Click the Forward button when you are done.

Next, you should see the “Receiving Email” screen. On this screen, you need to provide
Evolution with the details of your email servers. If you do not know these details, you will
need to ask your network administrator or check with your email provider.

There are two common types of internet email connections: IMAP, and POP. These are
described below. In work environments there are sometimes other types, such as Microsoft
Exchange or Novell GroupWise — for more information on those types of connections, please
see the documentation for Evolution.

Setting up an IMAP connection

IMAP connections allow you to manage your email remotely — the actual email and folders
reside on your email server, while Evolution allows you to view, edit, and delete the messages
and folders as needed.

If your email provider recommends an IMAP connection, select IMAP in the Server
Type field. In the Server field, enter the internet name of your mail server. For example,
imap.gmx.com. In the Username field, enter the username that you use to log into your
email system, for example joe.x.user.

Your email provider may specify the security settings you will need to use in order to
receive email. If your connection does not use security, leave the Use Secure Connection
field set to No encryption. Otherwise, select either TLS encryption or SSL encryption
as recommended by your email provider.

After selecting these options, click the Forward button to proceed to “Receiving Options”
screen. While it is normal to leave all options unselected, you may want to select the Check
for new messages option to have Evolution automatically check email on a regular basis.

When you are finished setting the options, click the Forward button to continue to the
next screen.



standardanwendungen 36

Setting up a POP connection

POP connections let you manage your email locally — Evolution will connect to your email
provider and download any new messages you may have received, and store them in folders
on your computer. The messages will be deleted off the server.

If your email provider recommends an POP connection, select POP in the Server Ty-
pe field. In the Server field, enter the internet name of your mail server. For example,
pop.gmx.com. In the Username field, enter the username that you use to log into your
email system, for example joe.x.user, or joe.x.user@gmzx.com.

Your email provider may specify the security settings you will need to use in order to
receive email. If your connection does not use security, leave the Use Secure Connection
field set to No encryption. Otherwise, select either TLS encryption or SSL encryption
as recommended by your email provider. After selecting these options, click Forward to
proceed to the next screen.

After selecting these options, click the Forward button to proceed to “Receiving Options”
screen. While it is normal to leave all options unselected, you may want to select the Check
for new messages option to have Evolution automatically check email on a regular basis.

You may also wish to adjust the Message Storage options, which determine what Evolution
does after downloading email to your computer. Select the Leave messages on server
option to have Evolution keep the messages on your email system after downloading them.
This will allow you to use another computer to redownload all of your new messages. Select
the Delete after 7 days option to have Evolution keep the messages for a few days, and
delete them after a while. You can adjust the number of days that Evolution keeps the
messages.

When you are finished setting the options, click the Forward button to continue to the
next screen.

Setting up your Sending options

The next screen should be the “Sending Email” screen. Here, you will need to configure your
connection for sending email through your email provider.

The most common type of sending connection is SMTP, which is the default server type
selected.

In the Server field, type in the name of the outbound mail server (also known as the
SMTP server), as described by your email provider. For example, mail.gmx.com.

If your email provider requires authentication, select the Server requires authentica-
tion option. This is common for commercial email providers. In the “Authentication” section
of the screen, select the type of authentication from the Type field — the most common
authentication type is “PLAIN”. Type your username in below, in the Username field, for
example joe.x.user, or joe.x.user@gmx.com.

Your email provider may specify the security settings you will need to use in order to
send email. If your connection does not use security, leave the Use Secure Connection
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field set to No encryption. Otherwise, select either TLS encryption or SSL encryption
as recommended by your email provider.

After selecting these options, click Forward to proceed to the next screen.
Finalizing account options

On the next screen, “Account Management”, enter in a descriptive name for this account.
If you plan to use more than one email provider with Evolution, you will use this name to
distinguish between the different accounts.

When finished, click the Forward button. This will bring you to the “Done” screen. If
you believe that you’ve entered the correct options, click the Apply button to finish setup.
Otherwise, click the Back button to go back one or more screens to correct your settings, or
the Cancel button to abort setup and discard your account settings.

After you finish setup, Evolution may ask you if you would like to make it your de-
fault email client. Click the Yes button if you plan on reading and sending email only with
Evolution. Click the No if you plan on installing or using a different email program.

Around the Evolution workspace

The Evolution window is divided into four parts. At the top are the menubar and toolbar.
The menubar lets you access most of the functionality of Evolution, while the toolbar provides
some convenient shortcuts to some of the most frequently used features.

On the left side of the window is the folder list. Every message that you send or receive
will reside in one of the folders in this list.

Below the folder list on the left side of the window are the Mail, Contacts, Calendars,
Tasks, and Memos buttons. When working with email, the Mail button is selected. The
other buttons take you to other parts of Evolution.

On the right side of the window are the message list, and the message preview beneath it.
The message list shows all of the messages in the currently selected folder, or matching your
search request. The message preview shows the contents of your currently selected message
in the list above the preview.

Understanding the folder list

The folder list is the way that Evolution separates and categorizes your email. The first group
of folders in the list is titled “On This Computer”. This set of folders are you local folders —
they reside on your computer only. If you use POP servers to retrieve your email, any new
message will be placed in the Inbox local folder.

You can click on any folder to see its contents appear in the message list on the right side
of the window.

Each of the initial folders in the list is special:

= Inbox stores your incoming messages.
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= Drafts stores messages that you've worked on, but have not yet sent.

= Junk stores messages that have been identified as being junk. Junk mail is also known
as “spam”.

= Outbox contains messages that you’ve finished composing, but which have not been sent
yet. For example, if you are working on your email whlie offline (such as in an airplane),
you can still click the Send button on an email message that you finish writing. The
message will be moved to the Outbox, and will remain there until the next time you are
able to send and receive messages. Once you can send and receive messages, all email
messages in the outbox will be sent out.

= Sent contains copies of messages that you had sent. Once a message from an Outbox is
sent, it is copied to the Sent folder.

= Templates stores email message templates — partial messages that you have composed
and saved as templates. You can use a message stored in the template folder as a starting
point for other messages.

= Trash contains messages that you have deleted. By default, the trash will be emptied
every time you exit Evolution.

If a folder contains any unread messages, the folder’s name will be displayed in bold, and
the number of unread messages will be displayed in parentheses following the folder name.

If you use an IMAP server to retrieve your email, then your remote IMAP folders will be
shown in the folder list below the “On This Computer” section. The list of remote folders
will be shown with a heading of the name that you have given to the account. With IMAP,
your email messages will arrive in your remote Inbox.

Towards the bottom of the folder list, Evolution will show a list of “Search Folders”. These
are special folders that represent certain messages that match search rules. Please see the
section on Finding Messages for more on search folders.

Managing folders

In addition to the initial folders, you can create your own folders to manage your email.

To create a new folder, choose the Folder menu, and then choose New. Type in a name
for the folder that you would like to create. Then, from the list of folders below, select the
parent folder. For example, if you would like your new folder to be placed under the Inbox
then select the Inbox folder. If you select “On This Computer”, then your new folder will be
placed under “On This Computer” in the folder list.

Once you’ve made your selection, click the Create button to create the folder. Your new
folder should now be in the folder list.

You can move folders that you have created. To do so, click on the folder that you would
like to move, hold down the mouse button, and drag the folder to a new parent folder. Once
the mouse cursor highlights a new parent folder, release the mouse button to finish the move.
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You can also right click on a folder, and select the Move... option. Then, select the new
parent folder, and click the Move button.

To delete a folder, right click on the folder and select the Delete option. To confirm that
you want to delete the folder, click the Delete button.

Checking and reading messages

Checking mail

When you finish setup, or when you start Evolution in the future, Evolution will first try to
connect to your email provider to check your email. In order to connect, Evolution will need
to know your email account password, and will ask you for it.

MISSING SCREENSHOT

“enter password” dialog

In the “Enter Password” window, enter your password and click the “OK” button. If you
wish for Evolution to remember this password and not ask you in the future, you can select
the Remember this password option.

Listing messages

The top right portion of the Evolution window is the message list. Here, you can see email
messages for your currently selected folder, or matching your search terms.

MISSING SCREENSHOT

Small view of the message list, showing column headers and a few email messages

By default, the message list shows six columns of information for each message. The first
column is a read/unread indicator. If a message has been read, the column shows an icon of
an open envelope. If a message has not been read, the icon will show a closed envelope.

The second column is an attachment indicator. If a message contains an attached file,
Evolution will show an icon of a paperclip in this column. Otherwise, the column will be
blank.

The third column is an importance indicator. If someone sends you a message marked
with high importance, Evolution will show an exclamation mark in this column. Otherwise,
this column will be blank.

The fourth column contains the sender of the message. Both the name and email, or just
the email address, may be displayed in this column.

The fifth column contains the subject of the email message.

Finally, the sixth column is the date that the email was sent.
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When you click on a message, its contents will be displayed in the preview pane below the
message list. Once you select a message by clicking it, you can click the Reply button in the
toolbar to begin composing a reply message to be sent to the sender, or click the Reply to
All button to begin composing a reply message to be sent to the sender and other recepients
of your selected message.

You can also click the Trash button in the toolbar in order to put the message in the Trash
folder, or the Junk button to put the message as in the Junk folder. Note that Evolution,
or your mail server, may automatically classify some mail as Junk.

In addition to the buttons on the toolbar, you can right click a message in the list.
Evolution will open a menu with actions that you can perform for the message.

Sometimes, you may wish to take an action on multiple email messages (for example,
delete multiple messages, or forward them to a new recepient). You can do this in Evolution
by holding down the Ctrl key while clicking multiple messages — the messages you click will
be selected. You can also click one message to select it, then press and hold the Shift key
and click on another message in the list. All messages in the list between the original selection
and the one you just clicked will be selected. Once you have multiple messages selected, right
click on one of them to perform your desired action.

Directly above the message list are the Show selector, and the search options. You can
use the Show options to filter your view to show only unread messages, or only messages
with attachments, etc.

The search options will be covered in a later section.
Previewing messages

When you select an email message, its contents will be shown in the preview pane below the
message list.

The top of the preview pane will show the message header, which contains the sender,
recepients, and subject of the message, as well as the date the message was sent. Below the
header, Evolution shows the contents of the message itself.

If a message was sent with HT'ML formatting, some of the images may not be displayed
when a message is previewed. To display the missing images, select View from the menubar,
then Load Images, or press Ctrl+I. If your internet connection is active, the missing images
should then load.

Opening messages
At times, you may want to display multiple messages at the same time. To do so, you can

open each message in a separate window instead of just viewing it in the preview pane.

The open a message in its own window, double click a message in the message list. The
message should then open in a separate window. You can go back to the message list and
open another message, if needed.

Note that loading images
may provide a way for the
sender to track your receipt
of the message. We do not
recommend loading images
in messages that you suspect
are Junk.
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Finding messages
Subscribing to IMAP folders
Composing and replying to messages
Composing new messages
Replying to messages

Using signatures

Staying organized
Managing your contacts
Adding or editing a contact
Searching for contacts
Managing your schedule
Viewing your calendar
Adding a new event
Working with others
Keeping a task list
Adding a task

Completing a task

Using instant messaging

Instant messaging allows you to communicate with people you know in real time. Ubuntu
includes the Empathy application that lets you use instant messaging features to keep in
touch with your contacts. To start Empathy, click Applications from the menubar, then
choose Internet and then Empathy IM Client.

Empathy lets you connect to many instant messaging networks. You can connect to
AIM™ Gadugadu, Google Talk, Groupwise, IQC®, Jabber®, MSN®, Myspace®, qq®, XMPP™,
Sametime®, Silc, SIP, Yahoo®, or Zephyr.
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Running Empathy for the first time

When you open Empathy for the first time you will need to configure it with the details of
your instant messaging accounts.

When Empathy starts you will see the “Welcome to Empathy” window. Choose the option
corresponding to your situation.

You have an account

If you have an account that you have used previously with another instant messaging program
then select the Yes, I’ll enter my account details now option. Then, click the Forward
button to continue.

On the next screen, choose your account type from the drop down box below What kind
of chat account do you have?. Then, enter your account details in the field below.

Depending on the account type that you choose, Empathy may request that you enter a
username, or an ID for your account, followed by a password.

If you do not remember your account information, you will need to visit the website of
the instant messaging network to retrieve that information.

If you have another account to add then select the Yes option, and click the Forward
button to repeat the above process. When you have entered all the accounts leave the No,
that’s all for now option selected, and click the Apply button to finish the setup process.

Next, Empathy should display the “Please enter personal details” screen. If you choose
to fill out this information, you will be able to communicate with people who are on your
local network either at home or in an office.

Enter your first name in the First name field, and your last name in the Last name field.
Type in a way that you would like to be identified on your local network in the Nickname
field. When you have filled all of the information, click the Apply button.

If you don’t want to communicate with people on your local network, select the I don’t
want to enable this feature for now option and click the Apply button.

You would like an account

If you don’t have an account that you can use, then you can create one by selecting the No, I
want a new account option. Click the Forward button to display the next set of options.

Choose the account type that you would like to create from the drop down below What
kind of chat account do you want to create? You can create either a Jabber® or a
Google Talk account.

Next, enter the account name that you would like in the text field, and in the proceeding
text field enter a password of your choice. If you would like to set up another account then
select the Yes option, and repeat the above process.

When you have entered all the accounts leave the No, that’s all for now option selected,
and click the Forward button.

Note: If you wish to create
another account type then
you will need to visit the
relevant website and follow
the “You have an account”
section.
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Empathy should display the “Please enter personal details” window. Providing this in-
formation allows you to communicate with people who are on your local network either at
home or in the workplace.

Enter your First name in the text field, and enter your Last name in the next field. In
the Nickname field enter a nickname by which you would like to be identified. When you
have filled all of the text fields click the Apply button to save your settings.

If you don’t want to talk to people on your local network then select the I don’t want
to enable this feature for now option and click the Apply button.

You want to talk to people nearby

If you would only like to communicate with people on your local network either at home or in
the workplace, then you should select the No, I just want to see people on-line nearby
for now option.

Click the Forward button to display the next set of options. Then enter your First
name in the text field, and enter your Last name in the next field. In the Nickname field
enter a nickname by which you would like to be identified. When you have filled all of the
text fields, click the Forward button.

Changing account settings

If you need to add more accounts after the first launch, then click the Edit then Accounts.
Empathy will then display the “Accounts” window.

Adding an account

To add and account click the Add button. Empathy should display some options on the right
hand side of the window. Choose your account type from the Protocol drop down. Next,
enter your account name in the first text field. Then enter your password in the Password
text field. Finally click the Log in button to save and verify your settings.

Editing an account

You might need to edit and account if you change the password or get the password wrong.
Select the account you want to change on the left side of the “Accounts” window. Empathy
should show the current settings for the account. Once you have made your changes, click
the Save button.

Removing an account

To remove an account select the account on the left hand side of the window and click the
Remove button. Empathy should open the “Do you want to remove” window. Click the
Remove button to confirm that you want to remove the account, or the Cancel button to
keep the account.
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Editing contacts

Adding a contact

To add an account click the Chat menu, then click Add contact, this opens the “New
Contact” window.

In the Account dropdown choose the account that you want to add the contact to. Your
must add you contact to an account type that matched theirs.

For example if your contact’s address ends in “@googlemail.com” then you will need to
add it to an account that ends in “@googlemail.com”. Likewise if the contact’s e-mail ends
in “@Qhotmail.com” then you would need to add it to an account ending in “@hotmail.com”.

When you have chosen the account that you wish to add the contact to, you will need
to add either their login id, username, screen name or e-mail address to the Identifier text
field.

Then in the Alias text field enter the contacts name as you would like to see it in your
contact list. Click the Add button to add the contact to your list of contacts.
Removing a contact
Click the contact that you want to remove and then click the Edit menu, then click Contact,
then click Remove. This will open the “Remove contact” window.

Click the Remove button to confirm that you want to remove a contact, or click the
Cancel button to keep the contact.

Communicating with contacts

Text

To communicate with a contact, choose the contact in Empathy’s main window and double
click their name. Empathy should open a new window where you can type messages to your
contact, and see a record of previously exchanged messages.

To send a message to the contact, type your message in the text field below the conver-
sation history.

When you have typed your message press the Enter key to send the message to your
contact. If you are talking to more than one person then all of the conversations will be
shown in tabs within the same window.

Audio

If your contact has audio capabilities then there will be an icon of a microphone next to their
name. Click the microphone icon to open a menu. Select the Audio call option from the
menu. Empathy should then open the “Call” window.
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This window shows your picture on the right and your contact’s picture on the left. Ensure
that your microphone and speakers are connected, and proceed with the audio conversation.
You can finish the conversation by pressing the Hang up button.

Video

If your contact has video chat capabilities then there will be an icon of a webcam next to
their name. Click the icon to open a menu. Select the Video call option from the menu.
Empathy should then open the “Call” window.

This window shows your webcam view in the top right and your contact’s webcam will
be in the middle.

If you don’t have a webcam then your picture will be shown instead. You can finish the
call by choosing the Hang up button.

Sending and receiving files
Sending a file

When you are in a conversation with a contact and you would like to send them a file, click
the Contact menu and then click Send file.

Empathy should open the “Select file” window. Find the file that you wish to send and
click the Send button. A “File Transfers” window will open showing the chosen file and its
transfer progress.

When the file transfer is complete, you can close the “File Transfers” window.
Receiving a file

When a contact wants to send you a file, the status icon to the left of the contact’s name
will flash with an icon of a paper plane.

To receive the file double click the contacts name. Empathy will open the “Select a
destination” window. Choose a location where you would like Empathy to save the file, and
click the Save button. Empathy should open the “File Transfers” window.

The “File Transfers” window shows you the progress of current file transfers. You can
stop file transfers by clicking the Stop button, open transferred files by clicking the Open
button, and clear the list of completed transfers by choosing the Clear button.

Changing your status

You can use your status to show your contacts how busy you are or what you are doing.
You can use the standard statuses, which are “Available”, “Busy”, “Invisible” and “Off-line”.
These can be changed in the main Empathy window from the drop down at the top of the
window.

The same drop down lets you set a custom status by choosing “Custom Message...” next
to the icon thats matches your status. Type what you would like your status to say, and click
the green tick.



standardanwendungen 46

Changing your picture

Your picture is what your contacts will see next to your name in their contact list. The
default picture is the outline of a person. You can change your picture by choosing the Edit
menu, then choosing Personal Information.

Emapthy should open the “Personal Information” window. From the Account drop down
choose the account that you want to change, then click the picture on the right hand side of
the window.

Empathy should open the “Select Your Avatar Image” window. Find the file cotnaining
your picture, and click the Open button. If you would like to return it to the default click
the No Image button instead.

Viewing and editing photos

To view and edit photos you can use a program called F-spot this can be found by clicking
the Applications menu, then Graphics, then F-spot Photo Manager. When you launch
F-spot for the first time you will see the “Import” window, how to use this is covered in
’Importing’.

F-spot displays your photos by date you can view photos from a specific month by clicking
that month in the time line near the top of the window.

You can play slide shows of you pictures by clicking the green play triangle.

A lot of this guide refers to the side bar on the left if you can’t see it click the View,
then click Componets and choose Sidebar making sure the option box is seleted.

Version system

So when you edit a photo F-spot creates a new version so that the original is not lost. You
can create a new version by clicking the Photo menu, then Create New Version.... This
opens the “Create New Version” window. In the Name text field you can type what you
would like to call the version and then click the OK button. A new version will have been
created.

You can view previous versions by clicking the photo that you wish to view then clicking
the Edit Image button. This changes the side bar on the left to the "Edit” side bar. In the
bottom left the Version drop down allows you to choose previous versions of the photo.

You might want to rename a version so that you remember which version is which. To
rename a version click the photo that you want to change, then click the Edit Image button.
This changes the side bar on the left to the "Edit” side bar. In the bottom left the Version
drop down choose the version of the photo that you want to rename. Then click the Photo,
then click Rename Version, this will open the “Rename Version” window. Enter the new
name in the New name text field, then if you want to rename the version click the OK
button, if you don’t want to rename the version click the Cancel button.

If when editing photos you may make a mistake and want to remove that version as you
don’t need it. To delete a version click the photo that you want to change, then click the Edit
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Image button. This changes the side bar on the left to the "Edit” side bar. In the bottom
left the Version drop down choose the version of the photo that you want to delete. Then
click the Photo, then click Delete Version, this will open the “Really Delete?” window.
If you want to delete the version click the Delete button, if you don’t want to delete the
version click the Cancel button.

Importing

When you launch F-spot for the first time you will see the “Import” window. After the first
launch you can import more photos by clicking the Import button.

When you import only the photos that you have just imported are shown to show all of
your photos click the grey Xto the right of the blue Find.

Where f-spot save photos

When importing pictures in the “Import” the “Copy files to the Photos folder” depends on
where the photos are saved.

If the “Copy files to the Photos folder” option is ticked then F-spot will copy the photos
into the Photos folder which is within the Pictures folder. The pictures are then sorted by
year, month and then date.

If the “Copy files to the Photos folder” option is un-ticked then F-spot will not copy the
pictures into the Photos folder.

From file

To import photos that are saved on you computer click Select Folder from the Import
Source drop down. This gives you the “Import” window, in this window navigate to the
folder that the photos are in and click the Open button.

When the loading bar says "Done Loading” all the photos in that folder and any sub-
folders are then displayed in the “Import” window. You can exclude importing photos from
sub-folders buy clicking the Include subfolders option so that the option is un-ticked.

All of the photos are imported by default, but you can choose individual photos by holding
down the Ctrl key. Duplicates are automatically detected when the Detect duplicates
option is selected.

You can attach tags by typing the names of the your current tags in the Attach Tags
text field. If you want to use multiple tags then separate them with a comma.

Once you have chosen the photos that you want import click the Import button.
From digital camera

Plug your camera into the computer and turn the camera on a new window should pop up,
check that Open F-spot is shown in the drop down and click the OK button. This will
show the “Import” window, in the Import Source drop down click the option that looks
like ...Camera.
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A “Select Photos to Copy from Camera...” window will open, you can then click the photos
that you want to copy. All of the photos are selected by default but you can add or remove
individual photos by holding the Ctrl key.

You can attach tags to all of them by clicking the Attach tag option and choosing the
tag in the Attach tag: drop down. For more information about tags see ”Organizing photos”

You can change where the files are saved in the Target location drop down. The default
is the Photos folder, this is where F-Spot saves the pictures.

Once you have chosen the pictures that you want to import click the Copy button.The
“Transferring Pictures” window opens and shows the copying progress, when the copying is
complete the progress bar will say Download Complete. Fianly Click the OK button to
show the pictures in F-spot

Organizing photos

F-Spot makes finding photos of the same type easier by using tags, you can apply as many
tags to a photo as you like.

You can apply tags to photos by selecting the photos and then right click and move the
mouse to Attach Tag and click the tag you want add. You can attach tags when importing
photos this is covered in the "Importing” section.

You can make new tags by clicking the Tags and clicking Create New Tag.... This will
open up the “Create New Tag” window, type the name of the tag in the Name of New
Tag: text field. The Parent Tag: drop down alows you to choose the tag that it is a sub-tag
of.

Editing Images

A photo might want to be edited to remove; something at the edge, discoloring, red-eye’s or
straighten a photo. To edit a photo click the one that you want to edit and then click the Edit
Image button. This changes the side panel on the left of the “F-Spot” window. The panel
shows eight options Crop, Red-eye Reduction, De-saturate, Sepia Tone, Straighten,
Soft Focus, Auto Color, Adjust Colors. Some of these options are explained in more
detail in the next section.

Crop

You might want to crop a photo to change the framing or remove part of the edge of the
photo. Click the Crop on the left panel, then in the Select an area to crop drop down
you can choose the ratio that you would like to crop with. You might want choose the ratio
that matches the ratio that you print, so that the photo is not stretched.

You can create custom constraints if one of the defaults does not meet your requirements.
This is done by choosing Custom Ratios from the Select an area to crop drop down.
This gives you the “Selection Constraints” window, click add this will place a new entry on
the left of the window.
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Once you have chosen your constraint, move the cursor to one conner of the section that
you want to keep. Click and hold the left mouse button and drag it to the opposite corner
of the section that you want to keep. You can then let go of the mouse button.

To resize the box move the mouse until an arrow points to the side that you want to
move. Click and hold the left mouse button, move the mouse until the edge is in the right
place.

All ratios work in portrait and landscape mode, to change between you need to click the
edge as if you were to resize the box. Moving the cursor between top right and bottom left
switches between portrait and landscape.

Red-eye Reduction

If you have taken a photo and the flash caused the subject to have red-eye’s this can be
removed by first clicking the Red-eye Reduction button. Move the cursor to the one corner
of the subjects eye and hold the left mouse button, then drag the cursor to the opposite corner
and let go of the mouse button.

This box can be moved by moving the cursor into the middle until a hand is shown, then
click and hold the left mouse button and move it into the correct place. When it is in the
correct place you can let go of the left mouse button.

To resize the box move the mouse until an arrow points to the side that you want to
move. Click and hold the left mouse button, move the mouse until the edge is in the right
place.

When the box covers all of the red in one eye click the Fix. You will need to repeat the
process for each of the subject’s eyes that is effected. and a

Straighten

If you have a photo that you took an is at an angle then the click the Straighten button.
Then move the slider until the picture is straight again. F-Spot will auto crop the picture to
remove any white parts that occur due to the rotation. When you are happy that the picture
is straight then click the Straighten button.

Auto Color

To automatically correct the coloring of the photo click the Auto Color button.

Exporting to web services

F-spot allows you to export you photos to a Web Gallery, Folder or CD and the following
services; SmugMug©, PicasaWeb™ Flickr™, 23hq and Zooomr™.

You can export to these services by chossing a picture and then clicking Photo the
Export to and click the service that you require. This will open a window in which you can
enter your account name and password, then you will be able to upload pictures.
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Watching videos and movies
$ sudo /usr/share/doc/libdvdread4/install-css.sh

Listening to audio and music



4 Preferences and Hardware

Using your devices

Keyboard and mouse

The keyboard and mouse are essential input devices for a large number of computer users
today. Being a very common piece of kit for many computer users has led to some variation in
the mouses and keyboards on offer today. In this section we will look at the different settings
of your keyboard and mouse which will be of great use to international users.

Keyboard

The keyboard is likely to be one of the main ways that you interact with your computer.
Without a keyboard this manual couldn’t be written by the Ubuntu Manual team! Unfort-
unately not all keyboards are uniform in design, they can differ by country, by language or
even by style. As an American if by mistake you purchase a keyboard from a UK retailer,
then not only will you find that the

Displays

Hardware Drivers

A hardware driver is a small bit of code packaged in a file, which tells your computer how
to utilize a piece of hardware. Every component in a computer requires a hardware driver
to function, whether it’s the printer, DVD player, hard disk, or graphics card. Your graphics
device is the component in your computer that powers your display. When you’re watching
videos on YouTube or DVDs or simply enjoying the smooth transition effects when you
maximize/minimize your windows, your graphics device is doing the hard work behind the
scenes.

Majority of the Graphics Devices are manufactured by three well known companies: In-
tel®, AMD/ATI®and nVidia®corp. You can find your device manufacturer by referring to
your computer manual or looking for the specifications of your particular model over the
Internet. The Ubuntu Software Center houses a number of programs that allow detailed
system information to be obtained. SysInfo is one such program that you can use to find
relevant information about your System devices. Ubuntu comes with support for graphics
devices manufactured by above companies, and many others, out of the box. That means
that you don’t have to find and install any drivers by yourself, Ubuntu takes care of it on its
own.

In keeping with Ubuntu’s philosophy, the drivers that are used by default for powering
graphics devices are open source. This means that the drivers can be modified by the Ubuntu
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developers and problems with them can be fixed. However in some cases the proprietary driver
(restricted driver) provided by the company may provide better performance or features that
are not present in the open source driver written by the developer community. In other
cases, your particular device may not be supported by the open source drivers yet. In those
scenarios, you may want to install the restricted driver provided by the manufacturer.

For both philosophical and practical reasons, Ubuntu does not install restricted drivers
from the start but allows the user to make an informed choice. Remember that restricted dri-
vers, unlike the open source drivers for your device, are not maintained by Ubuntu. Problems
caused by those drivers will be resolved only when the manufacturer wishes to address them.
To see if restricted drivers are available for your system, click System in the top panel, go
to Administration and find Hardware Drivers. If a driver is provided by the company
for your particular device, it will be listed there. You can simply click Activate and use the
driver if you want. This process will require an active Internet connection and will ask for
your password.

The Ubuntu developers prefer open source drivers because they allow the problem to be
identified and fixed by anyone with knowledge in the community. Ubuntu development is
extremely fast and it is a good chance that your device will be supported by open source dri-
vers. You can use the Ubuntu Live CD to check for your device compatibility before installing
Ubuntu or go online in the Ubuntu forums to ask about your particular device. Another use-
ful resource is the official online documentation (help.ubuntu.com), which contains detailed
information about various graphics drivers and known quirks.

Setting up your Screen Resolution

One of the most common display related tasks is setting up your screen resolution. Think
of Screen Resolution in terms of displayable information on the your monitor/LCD; the
higher the resolution, the better the result. Your monitor/LCD has a "native resolution”,
which is the highest resolution it designed to work at. Ubuntu correctly identifies that screen
resolution by itself and sets it for you. However, due to a huge variety of devices out there,
sometimes it can make a mistake and set up an undesirable resolution.

To set up or just check your screen resolution, go to System. Click Preferences and
find Display. The Display application shows you your monitor name and size, the screen
resolution and refresh rate. Clicking on the displayed resolution for e.g. 1024 x 768 (4:3),
would open a drop-down menu from where you can select the resolution of your choice.

Connecting and using your printer
Sound

USB drives

Burning CDs and DVDs



Using a webcam
Scanning text and images
Other devices

Firewire

Bluetooth
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5 Software and Packaging

Software Management in Ubuntu

One of Ubuntu’s main objectives is to deliver you the applications that you will need in a
system-standard way, so that you can have software that is secure, stable and up-to-date,
installed easily and rapidly. That is why Ubuntu uses an advanced software management
system.

Differences With Other Operating Systems

In other operating systems, to install a package you would normally obtain an installer file,
from a CD or a download site on the Internet, and run it to install an application.

In Ubuntu, the same principle is followed, but the process varies a bit. To obtain a package,
you just need to open the Software Center, and install the application you want with the
click of a button. There are more than 25,000 packages available that you can install. All
free and open-source. Find out more about Software Center in the respective section.

You will now probably wonder which applications will you be able to install. Well, Ubu-
ntu’s software all comes from repositories. After a clean install you will have only the
official Ubuntu repositories in your software sources, but later on you can add as many
repositories as you want. Learn how to in the Software Sources section.

Package managers make your life easier

Package managers—like the Software Center—are the applications that interact with the
repositories. The package managers will let you search for, view information about, install
and remove applications, at least. Other additional actions or information you will be able
to reach depend entirely on the package manager you are using.

The principal package managers that Ubuntu provides are the Software Center and the
Synaptic Package Manager. To find out more about them, read the respective sections
in this chapter.

Different Ways to Obtain Software

Even though Ubuntu uses a systematic way to obtain software, that does not mean that it
is the only way to do it. You can obtain your software through the following sources:

1. Official repositories, which is the standard method to get software. By getting software
through the official repositories you ensure that your software is free of viruses or any
other malware, that it is stable, and that it works with Ubuntu.
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2. Third-party repositories that you can add to expand your software sources. Now,
these repositories are not as convenient as the official ones: that the owner can put into
them whatever he wants; there is no solid guarantee that the software inside them is
secure, stable, or that it works with your system. Read more instructions on this matter
at Software Sources.

3. Installers / Deb packages that you can download from software websites, CDs, USB
drives, etc. This method is the most insecure of all. You should only obtain software this
way when you trust the source. If you are new to Linux, then you are probably accustomed
to obtain software this way.

Software Center

The Software Center is Ubuntu’s main package manager. The main appeals of the Soft-
ware Center are that it is a simple, organized, and intuitive package manager. It is designed
with the purpose of requiring no guide or manual to its usage; however, we will guide you
through some simple operations below.

First off, to open the Software Center go to Applications> Ubuntu Software Cen-
ter.

Installing Software

Now, installing applications, is two mouse clicks away. Once you find the software you are
looking for,

1. Click on the = button to the right of the selected application. You will be taken to the
application’s profile page. If you want to go back, you can click on the buttons on the top,
they will most likely look like this: Get Free Software > Selected Category > Selected
application.

2. Click the Install button. If you are not running as root, you will be asked to input your
password. If your authentication was granted, you will be taken to the In Progress
section while your application is installed.

3. Wait until the application is finished installing. When operations—such as application in-
stallations and removals—are currently running, you will see an animated icon of rotating
arrows to the left of In Progress section in the sidebar, and parentheses enclosing the
number of uncompleted operations. While the application is installed, you can read details
about the current operation, watch the progress bar fill out, or click the <stock-cancel >
icon to cancel the operation.

Now you can run your application. Depending on the use of it, it will appear on the
Applications menu, System > Administration or System > Preferences.

Note: If your password does
not work, you are probably
not permitted to install
software on the computer. If
you have further problems,
please go to Kapitel 9:
Problembehebung.
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Removing Software

If you thought installing an application was easy enough, try removing one.

To remove an application, follow this instructions:

1. Find the application you want to remove (either by using the search bar or by filtering
through categories).

2. Go to its page by clicking on the = button to its right, on the application list.

3. Click the Uninstall button. If you are not running as root, you will be asked to input
your password. If your authentication was granted, you will be taken to the In Progress
section while your application is installed. Your application will now be either in process
of removal or waiting in line for it, in the In Progress section.

Now, as with when you install a new application, when you remove one the menus get
updated too. This is one of the assets of having an organized software management system
on your side.

Making More Software Available

The Software Center will only list the applications available in the repositories of your
software sources. To add more, or learn more about this, visit the Software Center section.

Synaptic Package Manager

The Synaptic Package Manager serves practically the same purpose as the Ubuntu Soft-
ware Center. Continue reading and you will determine whether you should use this application
or the Software Center application in the previous section.

The Synaptic Package Manager is the most complete visual package manager available
in Ubuntu. Through it, you will be able to access any package in your repositories; not just
user applications.

This application will come in handy when you are looking to perform actions other than
just installing and removing packages. The Synaptic Package Manager lets you:

= Install any package in your repositories. You can even select which version of a package
to install, but note that this option is not available for all the packages.

Reinstall in case the package’s contents have been damaged, or you just want to get the
default version back.

Update every time a new version of the package is released.

= Remove any package you no longer need.

Purge when you wish to remove completely a package, including saved preferences and
stored configuration files.

Note: You can open
Software Sources from the
Software Center. Simply
go to Edit > Software
Sources.

Note: If you are not very
familiar with advanced
computing in Ubuntu you
may probably want to stick
with the Software Center.
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= Fix broken packages.

= Check properties of any package, such as version, contained files, package size, depen-
dencies, and much more.

= Read and save markings in your computer.

Usage

Using this package manager is very simple once you understand the principle behind it.
Ideally, you will mark different actions to perform on different packages first, and then apply
your changes. When you click the Apply button, the Synaptic Package Manager will do
each of your marked actions, one by one. Then you will be free to close the application, or
wait until the process is complete to make more changes.

To open the Synaptic Package Manager go to System > Administration> Synaptic
Package Manager.

Finding What You Want

If you are having difficulties finding the package you are looking for, you may try the Quick
search box, the Search button (which opens a search dialog) or sort by the categories in
the left side pane.

You can use the Reload button when you have made changes to your software sources,
such as adding or removing repositories, so that the package manager can notice the changes
and act accordingly.

Applying Your Changes

Once you find the package you are looking for, you can just open its right-click menu and
there you will see listed all the actions you can perform on it. You can alternatively access
these options through the Package menu.

When you are ready marking actions, click the Apply button and wait until the changes
are made. Afterwards, you can close the application or mark more changes.

Software Sources

The Software Center—or the package manager you are using—will list only applicati-
ons that are available in the repositories of your software sources. You can add or remove
repositories to your software sources with the Software Sources application.

To start off, lets open the Software Sources application in the System > Administration >
Software Sources.
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Configuring the Ubuntu Repositories

Ubuntu has four main repositories—which classify as the official repositories—with different
kinds of packages each. Read below what area does each repository cover.

= Canonical-supported open source software (main) - This repository contains all
the open source packages that Canonical—the company behind Ubuntu—helps maintain.

= Community-maintained open source software (universe) - This repository con-
tains all the open source packages that the community—the users of Ubuntu—helps
maintain, or creates and convince Canonical that their software is good enough as to be
in an official repository.

= Propietary drivers for devices (restricted) - This repository contains all the drivers
available to devices or hardware you may use with your computer.

= Software restricted by copyright or legal issues (multiverse) - This repository
contains all other software that, as the name suggests, might be illegal to use in so-
me places. However, you can still use it if you enable this repository, under your own
responsibility.

The Source code checkbox should not be enabled unless you are used to building app-
lications from source.

Selecting the Best Software Server

Ubuntu grants permission to many servers all across the world to host exact copies of the
Ubuntu official repositories. Ubuntu does this so that, wherever you are, you may have a
server that is close to you to guarantee the best connection possible.

If your downloads are slow, you might be getting your software from the wrong server.
There are some aspects you should consider before selecting your server:

= Connection speed. Depending on the physical distance between you and your server,
the connection speed may vary. Luckily for you, Ubuntu had though about this long ago,
and thus provides a tool to select the server to which your computer connects the best.

To select the fastest server available for you, click the combobox of the current server
and select the Other menu option. After you are taken to the server selection window,
click on the Select Best Server button, to the upper right. You will have to wait for
your computer to connect to all the servers and then select the server with which it had
the fastest connection.

= Location. Unless you want to use your country’s Ubuntu server just because, your server’s
location should only be relative to the speed of the connection with it.

To select a server by country, click on the combobox of the current server. A window
with all the countries with Ubuntu servers and the respective servers registered to them,
will appear. Have fun.
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= Security. This should not concern you at all, now that Ubuntu knows well who it trusts
enough as to grant a copy of the repositories. However, if you still think you might be at
risk with just any server, you could select one of the Ubuntu secure servers, such as the
Main server or the http://ubuntu.securedservers.com server.

If you are not connected to the internet, you may insert your CD to your computer and
select the checkbox in the Installable from the CD-ROM/DVD box. Expect no more
than the Cdrom with Ubuntu 10.04 ’Lucid Lynx’ inside the box.

Configuring Updates

Because Ubuntu is a very customizable operating system, it lets you specify which kinds of
updates you will want to be getting. To customize your updates, go to the Updates tab, in
your Software Sources window.

Ubuntu Updates

This is where you specify which kinds of updates you will like to get installed in your system.
If you have doubts about any of the options, read a description of each below:

= Important security updates - These ensure that you get all the updates that make
Ubuntu such a secure operative system time and time again when they are released. As
the title suggests, it is important that you enable these updates.

= Recommended updates - These updates are not mandatory or important, but if you
wish to keep your whole system up-to-date, you should consider them.

= Pre-released updates - These updates are for those who just cannot wait whenever
new versions of applications are out. Note that these updates have not being tested
enough, so you may encounter problems with the updated applications. However, if you
did encounter a problem, you could easily roll-back to the previous version, using the
Synaptic Package Manager.

= Unsupported updates - These are the updates that the Ubuntu staff has not reviewed.
Even though they are secure, as with the previous ones, you may encounter problems
when using them.

Automatic Updates

Here you can customize your system’s behavior towards updates. You can customize whether
it checks for updates or not, if it should install important updates right away (without asking
for your permission), if it should only download them, or if it should only notify you about
them. You can also customize the frecuency with which your system checks for new updates.
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Release Upgrade

Here you can customize which kind of system upgrades you will like to have available.

= Never - Choose this if you don’t want to be notified about new Ubuntu releases, at all.

= Normal releases - Choose this if you always want to have the latest Ubuntu relase, no
matter if it is long-term-support or not. This option is recommended for normal, home
users.

= Long term support releases only - Choose this option if you need a release that will
have—as the title suggests—support for a long time. If you own a company and you have
Ubuntu as the operating system for your employees, you probably want to select this
option.

Adding More Software Repositories

As you have probably read before in this chapter, there is a way that you can get software,
from a package manager, from third-party—or non-Ubuntu—repositories. These “third-party
repositories” are called PPAs.

To add a PPA to your software sources, go to the Other Software tab in the Software
Sources window.

What You Will Need

1. The PPA intelligent url. To get it, go to the project owner’s launchpad page, whether it
is a team or a single launchpad user. When you are taken to the page, look for a header
labeled “Personal Package Archives”; click on the link to the one that best matches the
project you are trying to add a repository of. Then, you will be taken to a page titled
“PPA for (...)”. Look for a link below, in bold font, similar to this one: lp:package. Thats
your PPA intelligent url.

2. The key file. To get it, go to the same page where you got your PPA intelligent url. Now,
instead of copying that url, click on Technical details about this PPA link. Then click
the link below the “Signing key” header. Afterwards, make your last click on the 8-digit
code. Copy all the text in the page and save it as a text file. That file is your key file.

Adding the PPA and Authorizing the Key
After you have the requirements, adding a PPA is a two step procedure:

1. Add the PPA by clicking on the Add... button, and copying the PPA intelligent url to
the APT Line input box.

2. Authorize the key by going to the Authentication tab (in the Software Sources win-
dow) and clicking the Import Key File... button. That will open up a browser for you;
find your key file and you are done.

Before closing Software Sources, read the next section.

Note: Every 6 months,
Ubuntu releases a new
version of the operating
system. These are called
normal releases. Now, every
4 normal releases — or 24
months, for that matter —
Ubuntu releases a long term
support release. Long term
support releases, tagged as
LTS releases, recieve extra
effort from the developers so
they can be more stable, and
thus be used by companies
that need extra-reliable
software.

Definition: A PPA is a
Personal Package Archive,
or a third-party repository.
The PPAs are spaces where
people host digital projects,
such as applications,
documents, and many more.

Note: The key file is the
security method used by
Ubuntu to ensure that you
are the one who is adding
the PPA
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Getting Ready to Use It

Because Ubuntu needs to keep track of a long list—about 25,000 items long—of applications,
it just does not attempt to update it with every small change you make. You have to update it
every time you change a setting in Software Sources, such as adding a new repository /PPA.

Luckily for you, upon closing Software Sources you will be asked if you want to reload
the software sources. To do so, click the Reload button. After Software Sources finishes
reloading the database and closes itself, you will be able to access your package from any
package manager.



6 System-Wartung

Updating your computer

Cleaning Unused Packages

Mit der Zeit kann Ubuntus Paketsystem »apt« einen ungenutzten Zwischenspeicher anle-
gen. Dieser Zwischenspeicher enthélt gespeicherte Paketdaten von allen Paketen die jemals
auf diesem System installiert wurden. Mit der Zeit kann dieser Zwischenspeicher sehr grofl
werden.

To clear out these cache stores you can either use the clean, or the autoclean option
for apt-get. The clean command will remove every single cache item, where the autoclean
command only remove cached items that can no longer be downloaded. Items that can no
longer be downloaded are generally useless. To run these, head to a terminal and type:

$ sudo apt-get clean

Es kann sein, dass Pakete mit der Zeit nicht mehr benétigt werden. Wenn ein Paket
als Abhéngigkeit eines bestimmten Programms installiert wurde, so wird das Paket nicht
mehr bendtigt, wenn das Programm entfernt wurde. Das heifit, das Paket wird nicht mehr
gebraucht und kann mit der »autoremove«-Option entfernt werden.

Offnen Sie eine Befehlszeile und geben Sie:
$ sudo apt-get autoremove
ein, um die unnotigen Pakete zu entfernen.

Clearing The Package Cache

Performing a File System Check
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7 The Command Line

understanding the terminal

what is a terminal?

A terminal is the Ubuntu equivalent to a command prompt in windows. A terminal is the
user interface that gives the user access to what is called a shell. One of the most popular of
these and the one included by default in Ubuntu is BASH (Bourne Again SHell). It can be
opened through the main menu by going to:

Applications> Accessories > Terminal

This is what the default terminal looks like in Ubuntu 10.04 Lucid Lynx:

MISSING SCREENSHOT

Need a screenshot fo the default terminal here

Of course, while the default terminal is not very pretty it can be customized to suite your
needs easily.

using the command line

navigating directories

The pwd command is short for Print Working Directory it is used to find out which directory
you are currently in.

$ pwd /home/your-username/

The cd command is short for Change Directory it is used to(you guessed it) change from
one directory to another.

$ cd /directory/you/want/to/go/to/
getting a list of files
The Is command is used to get a list of all the directories and files in a directory.

$ 1s directoryl directory2 filel.txt file2.txt
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moving things around

The mv command is used to move a file from one directory to another.

$ mv /file/you/want/moved /directory/you/want/it/moved/to/

The cp command is used to copy a file from one directory into another.

$ cp /file/you/want/copied
/directory/you/want/it/copied/to/

creating directories
The mkdir command is used to create new directories.

$ mkdir name-of-new-directory

deleting files and directories

The rm command is used to delete files.

$ rm file-you-want-deleted

The rmdir command is similar to the rm command except it is used to delete directories.

$ rmdir /directory/you/want/deleted/

changing system settings
what is sudo?

When you first install Ubuntu two user accounts are created, the one that you created
and one called the root account, which is created automatically for you. The root account
has privileges to modify the core system files and settings. By using sudo, you can borrow
these privileges for administrative work, such as installing or removing software, creating or
removing new users and modifying system files.

MISSING SCREENSHOT

Need a screenshot of logging in as root here

You can find out more about using sudo in Kapitel 8: Sicherheit
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advanced command line use
aptitude or apt-get?
terminal vs shell: what's the difference?

There is an important difference between a terminal and a shell, a terminal provides input
and output functionality and a shell processes the user’s commands, the user accesses the
shell through the terminal.



8 Sicherheit

This chapter introduces how to keep your Ubuntu computer secure.

Why Linux is safe

In general Linux based systems such as Ubuntu are reasonably secure with setting installed
by default. This is for a number of reasons:

Linux has a clear divide between normal users and administrative users.

Open source software allows security flaws to be easily detected.

Security patches for open sources software are often released quickly.

= Many viruses target Windows based system and so do not affect Linux systems.

Security Basics

This section describes basic security concepts and procedures.

Sudo

Linux systems include a special user, root, which has full administration privileges. Where as
a normal user can only access their own files and can not make changes to the system such
as installing programs.

In Ubuntu the root account has been disabled to improve security and can not be used
directly. Instead the initial user account created during the install process has permission to
conduct administrative tasks by using the sudo command.

The sudo command allows a user to be given administration privilege for a specific task.
The following example runs the apt-get clean command as an super-user:

$ sudo apt-get clean

' sudo should only be used when needed. Operations that can be completed without sudo should
¢ be executed as the normal user.

In addition to sudo the Ubuntu Desktop has a graphical version of sudo for programs that
require administration permissions. For example if a during a system update the desktop is
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faded out and box asking for the user passwords appears; this is to grant administration
privileges permission to the user.

Users must be given permission to use the sudo command, this can be done by adding
users to the Admin group. See section Users and Groups for details of how to do this.

' Only users that need administration access should be giving sudo permission. Do not give
¢ administration all users to make administration easier.

Basic Security Precautions

Separate User Accounts

When Ubuntu is installed, it is set up for a single person to use. If more than one person
will use the computer, it is best for each person to have their own user account. This way
each user can have separate settings, documents, and other files. If necessary, files can also
be protected from being viewed or changed by other users without administrative privileges.
See Users and Groups for how to add additional users.

Passwords

Strong passwords are one of the simplest ways to increase the security of your computer.
Passwords should not use names, common words and phases.

By default the minimum length of a password in Ubuntu is 4 characters. This can be
changed by executing the following command, where the number following min and max are
the minimum and maximum length of a password.

$ password required pam_unix.so nullok obscure min=6 max=8
md5

Regularly changing passwords also help to improve security. A users passwords can be
set to expire after a given time. The current settings for a user password can be view by
executing the following command.

$ sudo chage -1 username

The following commands can be used to change the expiry date of a password.

Set the expiry date of the current password to 31st April 2010.
$ sudo chage -E 04/31/2010 username
Set the maximum number of days for a password to 90.

$ sudo chage -M 90 username
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Set today as the last day for the current password.

$ sudo chage -d username

The options of these commands above can be combined into a single command.
$ sudo chage -E 01/31/2008 -M 90 -d username

Locking the screen
When leaving your computer unattended lock the screen, this stops anyone using your com-
puter and requires your password to unlock the screen. To lock the screen:
= Click the User Switcher in the top right of the panel and then press Lock Screen, or
= Press Control+Alt+L to lock the screen. This keyboard shortcut can be changed in Sys-
tem > Preferences > Keyboard Shortcuts.
System Updates

Ubuntu provides software and security updates; these updates should be applied regularly.
See Kapitel 6: System-Wartung for how to update your Ubuntu computer.

Automatic Security Updates

Security Updates can be applied automatically. To do this:

1. Open Software Sources System > Administration> Software Sources.

2. Select the updates tab.

3. Under automatic updates, check the check for updates box and select the required
frequency of updates.

4. Select Install Security updates without notification.

Trusting Third Party Sources

Normally adding applications to your computer is done using the Software Centre which
downloads software from the Ubuntu repositories as described in Kapitel 5: Software and
Packaging. However sometimes it is necessary to added software from other sources. For
example when an application is not available in the Ubuntu repository or a newer version is
needed to the one available.

Additional repositories are available from site such as nd Launchpad PPAs which can be
added as described in Kapitel 5: Software and Packaging. Some applications can be downloa-
ded as .deb packages from a the website of a project. Alternately applications may be built
from the source code for the application.
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Using recognised sources such as a projects website, PPA or community repositories such
as s more secure than downloading applications from an arbitrary source.

Whenever using a third party source considered how trustworthy the source is and be
sure you know what you are installing.

Users and Groups

Linux systems, as with most PC Operating Systems, support multiple users accounts. This
allows each user to have a separate user account. Linux systems also have user groups, every
user is a member of one or more groups. Every user also has a group with the same name
as the user, of which the user is a member. Files and folders can be set to be accessible by a
user and a group. By default a users files are only accessible by the user and system files are
only accessible by the root user.

MISSING SCREENSHOT

Screenshoots of User and Groups window

Managing Users

Management of users and groups can be done using the User and Group administration
application, System > Administration> Users and Groups

To make adjustments to the user and group setting click the keys icon next the word ”Click

to make changes”. This will produce a promote for your password to grant sudo privileges
while using the User and Groups application.

Adding a User Click the Add User button and complete the dialog which appears.
Privileges granted to the new user can be changed in the Privileges tab, but in most cases
the defaults privileges will be adequate. To create the user click the OK button.

Modify a User Double click on a user in the list of users or select a user and click the
Properties button. Change the details as required in the dialog that appears. Click OK to
apply the changes.

Delete a User Select a user from the list and click the Delete button. This will deactivate
the users account, but not remove the home folder.

Managing Groups
Click the Manage Groups button to open the group management dialog.

Adding a group To add a group click the Add button. In the dialog window that appears
enter the group name and select the members of the group.

Modifying a group To alter the users in an existing group. Select a group and click the
Properties button. Select and de-select the users as required and click OK to apply the
changes.
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Deleting a group To delete a group select a group and click delete.
Applying Groups to Files and Folders

To change the group of a file of folder open Nautilus and navigate to the file or folder which
need the group to be changed. Then either select the folder and use the File> Properties
menu item or right click on the file / folder and select Properties. In the Properties dialog
that appears Click the the Permissions tab and select the required group from the Groups
dropdown box, and select close.

Using the Command Line

User and group management can also be achieved by using the command line. It is recom-
mended you use the graphical method above unless you have good reason to use the command
line. For more information see the Ubuntu Server Guide https://help.ubuntu.com/9.10/
serverguide/C/user-management.html

Setting up a Secure System

This section describes how to use additional security programs to increase the security of
your system.

Firewall

A firewall is used protect your computer against unauthorized access by people on the Internet
or your network. Firewalls block connections to your computer from unknown sources, which
helps to prevent security breaches.

Uncomplicated Firewall (UFW) is the standard firewall configuration program in Ubuntu.
It is a command line program, but there is a graphical interface for it called Gufw. See
Kapitel 5: Software and Packaging for how to install the Gufw package.

MISSING SCREENSHOT
GUFW Window with Add service window

Once installed started Gfuw System> Administration> Firewall configuration. To
enable the firewall click the Enable check by default all incoming connections are denied.
This should be suitable for most users.

If you are running servers on your system you will need to open the ports these services
use. If you do not know what this means, then you are probably not running any servers and
you should not open any ports.

To open a port click the Add button. For most usages the the Preconfigued tab can be
used. Select allow from the first box and then select the program or service required.

The simpletab can be used to allow access on a single port and the Advanced tab can
be used to allow access on a range of ports.
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Encryption

Ubuntu includes a number of tools to encrypt files and folders. Two common methods will
be covered here. For further information on using encryption with single files and email see
the Ubuntu Community Help https://help.ubuntu.com/community.

Home Folder

During the install process it is possible to chose to encrypted a user home folder, see Kapitel 1:
Installation for how to do this.

Private Folder

If you have not chosen to encrypt a user home folder it is possible to encrypt a single folder
in a users home folder named Private. To do this:

1. Install ecryptfs-utils.

2. Run ecryptfs-setup-private to setup the private folder.
3. Enter your login password when prompted.

4. Either choose a mount pass phrase or generate one.

5. Record both pass phrases in a safe location. These are required if you ever have to
recover your data manually.

6. Logout and Log back in to mount the encrypted folder.

After the Private folder has been setup any files or folders in Private folder will be
encrypted when written to the disk.

If you need to recover your encrypted files manually see https://help.ubuntu.com/community/
EncryptedPrivateDirectory#RecoveringYourDataManually
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9 Problembehebung

Resolving Problems

Sometimes, things simply do not work as they are supposed to. From time to time, we have
all encountered problems setting up and using our Ubuntu systems, but these glitches are
generally easily fixed. Below, we offer a troubleshooting guide to help resolve basic problems
that users may encounter while using Ubuntu. If you exhaust the troubleshooting advice
below, there are plenty of other options for getting assistance and support. See Section 9.3:
Getting More Help to learn about community support.

Troubleshooting Guide

The key to effective troubleshooting is to work slowly and remain calm. Often, problems
we encounter can be remedied rather easily, but becoming frustrated and dealing with the
issue erratically can complicate the situation. Therefore, we advise that you work through
your problem slowly and methodically, documenting the changes you make to your Ubuntu
system. That way, you will always be able to roll back your work and also give fellow users
information about your previous attempts, in the unlikely event that you should need to turn
to the community for support.

| installed Windows and can no longer start Ubuntu

When you first turn on your computer, Ubuntu or another operating system must also be
started by the bootloader. When you installed Ubuntu, you installed an advanced bootloader
called GRUB that allowed you to choose between the various operating systems on your
computer, like Ubuntu, Windows and others. However, when you installed Windows, you
removed GRUB, taking away the option of which operating system to start. You can easily
restore GRUB and your bootloader choice by using the CD you used to install Ubuntu.

Insert your Ubuntu CD into your computer and restart, making sure to have your com-
puter start the operating system that is on the CD itself (see Kapitel 1: Installation). Choose
your language and select Try Ubuntu. Wait while the software loads, and then open a
terminal. You will have to use some code to restore your bootloader. On the Applications
menu, click Accessories, and then click the Terminal item. Enter the following:

$ fdisk -1 Disk /dev/hda: 120.0 GB, 120034123776 bytes 255

heads, 63 sectors/track, 14593 cylinders Units = cylinders of 16065 *
512 =

8225280 bytes

Device Boot Start End Blocks Id System /dev/sdal 1 1224 64228+ 83 Linux

Definition: A bootloader
is initial software that loads
the operating system when
you turn on the computer.
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/dev/sda2 * 1225 2440 9767520 a5 Windows /dev/sda3 2441 14593 97618972+
5

Extended /dev/sda4 14532 14593 498015 82 Linux swap

Partition table entries are not in disk order

This output means that your system (Linux) is installed on device /dev/sdal, but your
computer is booting to /dev/sda2. First, you need to create a place to manipulate your
Ubuntu installation.

$ sudo mkdir /media/root

Now, you need to link your Ubunut installation and this new folder.

$ sudo mount /dev/sdal /media/root

If you’ve done this correctly, then

$ 1s /media/root bin dev home 1lib mnt root srv usr boot

etc initrd 1ib64 opt sbin sys var cdrom initrd.img media proc selinux
tmp

vmlinuz

Now, you can reinstall GRUB.

$ sudo grub-install --root-directory=/media/root /dev/sda

Installation finished. No error reported. This is the contents of the
device map /boot/grub/device.map. Check if this is correct or not. If
any

of the lines is incorrect, fix it and re-run the script “grub-install'.
(hd0) /dev/sda

Now, reboot your Ubuntu Live CD, removing the disk from the tray and enjoy your
Ubuntu system once again!

My login screen no longer appears when | turn on my computer or

The graphics on my screen appear corrupted

The simplest and easiest way to correct this issue is to order Ubuntu to reset the graphics
configuration. Press and hold Control. Alt and F1. You should now see a black and white
screen with a prompt for your username and password. Enter your username, press Enter,
and then enter your password. Characters will not appear on the screen as you enter your
password. Do not worry—this behavior is normal and was implemented for security purposes.
Then, enter the following code and press enter.
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$ sudo dpkg-reconfigure -phigh xserver-xorg

Enter your password at the prompt, as above. Allow Ubuntu to process the command, then
enter

$ sudo reboot now

Ubuntu will reboot, and your login screen should be restored.

| forgot my password

WEell, it happens to the best of us. Luckily, resetting your password is trivial. As the computer
boots up, press Esc when you see the white-on-black screen with a countdown (the GRUB
prompt). Select the Rescue mode option, which should be the second item in the list. Wait
while Ubuntu starts up. You will not see a normal login screen. Instead, you will be presented
with a terminal prompt along the lines of

root@something#
To reset your password, enter
$ passwd username

Replace 'username’ above with your username. Ubuntu will prompt you for a new password.
Enter your desired password, press enter and then enter your password again, pressing enter
after you are done. Ubuntu asks for your password twice to make sure you did not make a
mistake while typing. Once you have restored your password, return to the normal system
environment by entering

$ init 2
Login as usual and continue enjoying Ubuntu.

Some text looks incorrect or corrupted

If you are seeing some text that looks odd or fails to display entirely, the designer probably in-
tended it to be veiwed using Microsoft fonts. This can be fixed by installing the missing fonts,
available in the Universe repository. See Kapitel 5: Software and Packaging (Configuring the
Ubuntu Repositories) to enable this repository.

Open the Synaptic Package Manager by navigating to the System menu in the top-
left corner of the screen. Synaptic is listed under the Administration submenu. Enter your
password when prompted. In the search box in the top toolbar of the application, enter
mscorefonts. Mark the package ttf-mscorefonts-installer for installation. Click Apply
in the top toolbar, then wait while Ubuntu installs the fonts.
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Refreshing the troublesome page or reopening the offending document should fix the
problem.

Where are my deleted files?

You believe that you have hit the delete key and erased a file from your Ubuntu system!
Do not worry. Just like other major operating systems, Ubuntu has a Trash folder where
deleted files are stored. To access it, select the Places menu, click on Computer and then
click Trash in the left-hand sidebar of the resulting window. To remove items from the trash,
simply drag and drop them whereever you would like.

I can’t play certain audio or video files, or interact with some websites

Many of the formats used to deliver rich media content are proprietary, meaning they
are not free to use, modiy and distribute, like Ubuntu is. Therefore, the default Ubuntu
installation does not include the ability to use these formats. If you still find yourself in need
of a closed format, you may install the necessary files with one command. Make sure you
have your Universe and Restriced repositories enabled. See Kapitel 5: Software and Packaging
(Configuring the Ubuntu Repositories) to enable this repository.

Open the Synaptic Package Manager by navigating to the System menu in the top-
left corner of the screen. Synaptic is listed under the Administration submenu. Enter your
password when prompted. In the search box in the top toolbar of the application, enter
ubuntu-restricted-extras. Mark the package ubuntu-restricted-extras for installation.
Click Apply in the top toolbar, then wait while Ubuntu installs the appropriate software.

Once this command has finished, your rich media content item should work properly.
Everything on my monitor is too big or too small or

How can | change my screen resolution?

The image on every monitor is made up of millions of little colored dots. Changing the number
of dots displayed is called changing the resolution and is generally done through software.
Increasing the resolution with make the displayed images sharper, but will also tend to make
them smaller. The opposite is true when screen resolution is decreased.

The Ubuntu program Display allows users to change the resolution. Open it by navi-
gating to the System menu in the top-left corner of the screen and then proceeding to the
Preferences sub-menu, then selecting Display. The resolution can be changed using the
drop-down menu within the program. Picking options higher up on the list, those with larger
numbers, will increase the resolution.

Test out various resolutions by clicking Apply at the bottom of the window. Confirm or
undo the change in settings in the resulting dialog window. When you have finished setting
the screen resolution, click Close.
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| would like to free up some disk space

One easy way to clear some disk space is to remove the installation files of each package
on your Ubuntu system. These files are known as the cache associated with each package.
Removing these leftover files is easy and will not affect the normal operation of Ubuntu.

Open a Terminal by navigating to the Accessories sub-menu under the Applications
menu in the top-left corner. Enter the following commands, entering your password when
prompted.

$ sudo aptitude clean ... $ sudo
aptitude autoclean

Getting More Help

This guide does not cover every possible workflow, task or issue in Ubuntu, nor was it
ever meant to. If you require assistance beyond the information in the manual, there are
a variety of support opportunties online. You can access extensive and free documentation,
buy professional support services, query the community for free support or explore technical
solutions. More information is available here: http://www.ubuntu.com/support



10 Learning more about Linux

What else can | do with Linux?

By now, you’ll be able to use your Ubuntu desktop to do all your normal day to day activities
like browsing the web and editing documents. But you may be interested to find out what
else you can do with a Linux-based computer. Linux computers are powerful tools that can
be put to a wide range of uses, only a small subset of which you’ll ever need.

Free and Open Source software (FLOSS)

It’s well worth knowing a little bit about the philosophy that gives Linux its power. When
you hear the word “Free” used in the context of software, it’s often referring to “free as in
speech”. However, the dual meaning of the word “free” led to some people suggesting the
phrase “open source” to describe the methodology behind Linux. You may also encounter
the abbreviation “FLOSS”, which stands for “Free, Libre, and Open Source Software”. These
terms all mean the same thing: anyone who wants to can download the source code for a
program. This may not seem like a big deal, but it allows computer programmers all over
the world to contribute to Free software projects, often leading to a better program. All of
the programs that come with Ubuntu by default are Free software.

Other distributions

Ubuntu is only one version of Linux; there are lots more around. While they may look pretty
different at first glance, they are all pretty similar under the covers.

There are two broad families: Debian based and Red Hat based. Ubuntu is based on
Debian, as are Linux Mint, Xandros and Crunchbang Linux. Red Hat based distributions
include Fedora, OpenSUSE, and Mandriva. The big difference between Debian-based and
Red Hat-based distros is the package management system. Debian packages are .deb files,
which Red Hat packages are .rpms.

There are also distros specialised for certain tasks. Examples of this include Mythbu-
ntu, which is designed to be used on home media centres, and Ubuntu Studio, intended for
multimedia production.

Eine Version auswahlen

Es gibt verschiedene Versionen, unter denen Sie wéhlen kénnen. Welche davon fiir Sie am
besten ist, konnen Sie entscheiden:

= Ubuntu-Desktop

Definition: The source
code of a program is the
files that the have been
written to make the
program.

Distribution: A
distribution, or distro, is a
set of Linux programs
bundled together to make it
easier to install and use.
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Kubuntu

Ubuntu Server-Edition
Ubuntu Netbook Edition
Kubuntu Netbook-Edition

Xubuntu

Ubuntu uses the Gnome (GNU Object Model Environment) desktop environment, while
Kubuntu uses KDE and Xubuntu uses XFCE respectively. Gnome is the most common, and
easiest to use — KDE provides more features, customization and settings, while XFCE is a
lightweight desktop environment designed to run on older computers. This manual will focus
on Ubuntu and Gnome.

Die Server-Edition kommt ohne Desktop-Umgebung aus. Sie wird von der Befehlszeile
aus bedient.

Die Netbook-Editionen sind fiir besonders kleine Bildschirme optimiert.

32 bit or 64 bit?

Ubuntu is available in two flavors: 32-bit and 64-bit. This difference refers to the way compu-
ters process information, with 64-bit processing using a little bit of additional memory while
gaining a little bit of additional performance.

Why should you choose one versus another? With Ubuntu, you will not see much difference
for most common uses. The few times when you may want to be aware of the flavor that you
choose are:

= If your computer is fairly old (made before 2007), you may want to install the 32-bit
flavor

= If your computer has more than 4GB of memory (RAM), you may want to install the
64-bit flavor

In general, we recommend that you install the 64-bit flavor of Ubuntu.

Servers

Almost all of your day-to-day work can be carried out on a normal Linux distribution.
However, there are some tasks which need something more specialised. These include running
a website or a mail system. For these, you are much better off using a specialised server distro
and hardware. These computers are on all the time and use quite a lot of power. It is possible
to run these things on a normal desktop computer, but this is recommended only for testing
things out.

This is not the best place to explain in detail about how to run a secure webserver; for
that, you’d be best off using the Ubuntu Server guide, found at http://doc.ubuntu.com/
ubuntu/serverguide/C/.


http://doc.ubuntu.com/ubuntu/serverguide/C/
http://doc.ubuntu.com/ubuntu/serverguide/C/
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Finding out more

This manual is not intended as a complete introduction to everything you could want to
do with your Ubuntu computer. For that, you should try looking at the official Ubuntu
documentation available either through the blue help and support icon, or on http://help.
ubuntu.com.

Extra Applications

Ubuntu bringt viele Programme von Haus aus mit, aber es gibt noch mehr tolle Anwendun-
gen, die iiber das Software-Center verfiigbar sind, die viele Aufgaben besser erledigen als die
mitgelieferten. Hier folgt nun eine Liste mit niitzlichen Anwendungen, die sie ausprobieren
sollten.

Cheese Webcam

If you’ve got a webcam on your laptop or attached to your computer, and you’d like to take
cheesy photos of yourself and your friends, then Cheese is the application for you. It supports
a lot of hardware and has features such as:

Numerous effects

Video recording

Self timer

Different resolutions

Burst mode

You can find it in the Software Center by searching for “Cheese”.

http://projects.gnome.org/cheese/
GIMP Bildbearbeitung

The GIMP Image Editor is the premiere image manipulation and enhancement program for
Ubuntu. Akin to Adobe Photoshop for Windows and Mac, the GIMP lets you do everything
you’ve been able to do in Photoshop, on Ubuntu — without the hefty pricetag.

Features:

Customizable interface allows you to set up the GIMP the way you want

Powerful photo enhancement

Digital retouching

Excellent hardware support for things like drawing tablets


http://help.ubuntu.com
http://help.ubuntu.com
http://projects.gnome.org/cheese/
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= Great file format support

= And it’s available for Windows and Mac as well!
Grab it from the Software Center by searching for “GIMP”.
http://www.gimp.org/
GNOME Do

Gnome Do allows you to get things done. You can quickly search for many items present on
your desktop or the web, and perform useful actions on those items.

Features:

= Awesome plugins let you send emails, play music, search the internet and much more

Swift and sleek interface integrates perfectly with your new desktop

Support for different themes to truly customize your experience

Also includes an optional Dock

Once again, available in the Software Center under “Gnome Do”.
http://do.davebsd.com/

Google Chrome
Jokosher Audioeditor
Pitivi Video Editor
Sun VirtualBox

VLC Mediaplayer

Der VLC Mediaplayer ist eine tolle Open-Source-Anwendung, die mit fast allem umgehen
kann. Vielleicht kennen sie die Windows-Version von VLC, denn es wird nicht nur fiir Li-
nux entwickelt. VLC kann fast jeden Video-Codec abspielen und unterstiitzt noch mehr
Audio-Formate. Auflerdem bietet er Unterstiitzung zum Abspielen von DVDs, Aufnahme
von Inhalten und dem Musik-Streaming.

Install it from the Software Center by searching for “VLC”.
http://www.videolan.org/


http://www.gimp.org/
http://do.davebsd.com/
http://www.videolan.org/
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Wine

Wine is an essential tool for Ubuntu users who wish to run Windows applications on their
machines without the need of running a virtual machine such as VirtualBox. Although not
every program will work under Wine, a lot of Windows software will work just as if they were
running under an installation of Windows XP such as Microsoft Office, World of Warcraft
and Counter Strike.

Install the version from the Software Center by searching for “Wine”, or get the latest
version from their website:

http://www.winehq.org/


http://www.winehq.org/

A License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS
CREATIVE COMMONS PUBLIC LICENSE (“CCPL” OR “LICENSE”). THE WORK IS
PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF
THE WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR COPY-
RIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU AC-
CEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. TO THE
EXTENT THIS LICENSE MAY BE CONSIDERED TO BE A CONTRACT, THE LI-
CENSOR GRANTS YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF
YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

(a) “Adaptation” means a work based upon the Work, or upon the Work and other
pre-existing works, such as a translation, adaptation, derivative work, arrangement of
music or other alterations of a literary or artistic work, or phonogram or performance
and includes cinematographic adaptations or any other form in which the Work may
be recast, transformed, or adapted including in any form recognizably derived from
the original, except that a work that constitutes a Collection will not be considered
an Adaptation for the purpose of this License. For the avoidance of doubt, where the
Work is a musical work, performance or phonogram, the synchronization of the Work
in timed-relation with a moving image (“synching”) will be considered an Adaptation
for the purpose of this License.

(b) “Collection” means a collection of literary or artistic works, such as encyclopedias
and anthologies, or performances, phonograms or broadcasts, or other works or sub-
ject matter other than works listed in Section 1(f) below, which, by reason of the
selection and arrangement of their contents, constitute intellectual creations, in which
the Work is included in its entirety in unmodified form along with one or more other
contributions, each constituting separate and independent works in themselves, which
together are assembled into a collective whole. A work that constitutes a Collection
will not be considered an Adaptation (as defined below) for the purposes of this Li-
cense.

(¢) “Creative Commons Compatible License” means a license that is listed at http:
/ /creativecommons.org/compatiblelicenses that has been approved by Creative Com-
mons as being essentially equivalent to this License, including, at a minimum, because
that license: (i) contains terms that have the same purpose, meaning and effect as the
License Elements of this License; and, (ii) explicitly permits the relicensing of adap-


http://creativecommons.org/compatiblelicenses
http://creativecommons.org/compatiblelicenses
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tations of works made available under that license under this License or a Creative
Commons jurisdiction license with the same License Elements as this License.

(d) “Distribute” means to make available to the public the original and copies of the

Work or Adaptation, as appropriate, through sale or other transfer of ownership.

(e) “License Elements” means the following high-level license attributes as selected by

Licensor and indicated in the title of this License: Attribution, ShareAlike.

(f) “Licensor” means the individual, individuals, entity or entities that offer(s) the Work

under the terms of this License.

(g) “Original Author” means, in the case of a literary or artistic work, the individual,

individuals, entity or entities who created the Work or if no individual or entity can
be identified, the publisher; and in addition (i) in the case of a performance the actors,
singers, musicians, dancers, and other persons who act, sing, deliver, declaim, play in,
interpret or otherwise perform literary or artistic works or expressions of folklore; (ii)
in the case of a phonogram the producer being the person or legal entity who first
fixes the sounds of a performance or other sounds; and, (iii) in the case of broadcasts,
the organization that transmits the broadcast.

(h) “Work” means the literary and/or artistic work offered under the terms of this Licen-

se including without limitation any production in the literary, scientific and artistic
domain, whatever may be the mode or form of its expression including digital form,
such as a book, pamphlet and other writing; a lecture, address, sermon or other work
of the same nature; a dramatic or dramatico-musical work; a choreographic work or
entertainment in dumb show; a musical composition with or without words; a cine-
matographic work to which are assimilated works expressed by a process analogous
to cinematography; a work of drawing, painting, architecture, sculpture, engraving
or lithography; a photographic work to which are assimilated works expressed by a
process analogous to photography; a work of applied art; an illustration, map, plan,
sketch or three-dimensional work relative to geography, topography, architecture or
science; a performance; a broadcast; a phonogram; a compilation of data to the extent
it is protected as a copyrightable work; or a work performed by a variety or circus
performer to the extent it is not otherwise considered a literary or artistic work.

“You” means an individual or entity exercising rights under this License who has not
previously violated the terms of this License with respect to the Work, or who has
received express permission from the Licensor to exercise rights under this License
despite a previous violation.

“Publicly Perform” means to perform public recitations of the Work and to commu-
nicate to the public those public recitations, by any means or process, including by
wire or wireless means or public digital performances; to make available to the public
Works in such a way that members of the public may access these Works from a place
and at a place individually chosen by them; to perform the Work to the public by
any means or process and the communication to the public of the performances of
the Work, including by public digital performance; to broadcast and rebroadcast the
Work by any means including signs, sounds or images.
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(k) “Reproduce” means to make copies of the Work by any means including without
limitation by sound or visual recordings and the right of fixation and reproducing
fixations of the Work, including storage of a protected performance or phonogram in
digital form or other electronic medium.

2. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or restrict any
uses free from copyright or rights arising from limitations or exceptions that are provided
for in connection with the copyright protection under copyright law or other applicable
laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby grants
You a worldwide, royalty-free, non-exclusive, perpetual (for the duration of the applicable
copyright) license to exercise the rights in the Work as stated below:

(a) to Reproduce the Work, to incorporate the Work into one or more Collections, and
to Reproduce the Work as incorporated in the Collections;

(b) to create and Reproduce Adaptations provided that any such Adaptation, including
any translation in any medium, takes reasonable steps to clearly label, demarcate
or otherwise identify that changes were made to the original Work. For example,
a translation could be marked “The original work was translated from English to
Spanish,” or a modification could indicate “The original work has been modified.”;

(c) to Distribute and Publicly Perform the Work including as incorporated in Collections;
and,

(d) to Distribute and Publicly Perform Adaptations.
(e) For the avoidance of doubt:

i. Non-waivable Compulsory License Schemes. In those jurisdictions in which the
right to collect royalties through any statutory or compulsory licensing scheme
cannot be waived, the Licensor reserves the exclusive right to collect such royalties
for any exercise by You of the rights granted under this License;

ii. Waivable Compulsory License Schemes. In those jurisdictions in which the right
to collect royalties through any statutory or compulsory licensing scheme can be
waived, the Licensor waives the exclusive right to collect such royalties for any
exercise by You of the rights granted under this License; and,

iii. Voluntary License Schemes. The Licensor waives the right to collect royalties,
whether individually or, in the event that the Licensor is a member of a collecting
society that administers voluntary licensing schemes, via that society, from any
exercise by You of the rights granted under this License.

The above rights may be exercised in all media and formats whether now known or
hereafter devised. The above rights include the right to make such modifications as
are technically necessary to exercise the rights in other media and formats. Subject to
Section 8(f), all rights not expressly granted by Licensor are hereby reserved.

4. Restrictions. The license granted in Section 3 above is expressly made subject to and
limited by the following restrictions:
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(a) You may Distribute or Publicly Perform the Work only under the terms of this
License. You must include a copy of, or the Uniform Resource Identifier (URI) for,
this License with every copy of the Work You Distribute or Publicly Perform. You may
not offer or impose any terms on the Work that restrict the terms of this License or
the ability of the recipient of the Work to exercise the rights granted to that recipient
under the terms of the License. You may not sublicense the Work. You must keep
intact all notices that refer to this License and to the disclaimer of warranties with
every copy of the Work You Distribute or Publicly Perform. When You Distribute or
Publicly Perform the Work, You may not impose any effective technological measures
on the Work that restrict the ability of a recipient of the Work from You to exercise
the rights granted to that recipient under the terms of the License. This Section 4(a)
applies to the Work as incorporated in a Collection, but this does not require the
Collection apart from the Work itself to be made subject to the terms of this License.
If You create a Collection, upon notice from any Licensor You must, to the extent
practicable, remove from the Collection any credit as required by Section 4(c), as
requested. If You create an Adaptation, upon notice from any Licensor You must, to
the extent practicable, remove from the Adaptation any credit as required by Section
4(c), as requested.

(b) You may Distribute or Publicly Perform an Adaptation only under the terms of: (i)
this License; (ii) a later version of this License with the same License Elements as this
License; (iii) a Creative Commons jurisdiction license (either this or a later license
version) that contains the same License Elements as this License (e.g., Attribution-
ShareAlike 3.0 US)); (iv) a Creative Commons Compatible License. If you license the
Adaptation under one of the licenses mentioned in (iv), you must comply with the
terms of that license. If you license the Adaptation under the terms of any of the
licenses mentioned in (i), (ii) or (iii) (the “Applicable License”), you must comply
with the terms of the Applicable License generally and the following provisions: (I)
You must include a copy of, or the URI for, the Applicable License with every copy
of each Adaptation You Distribute or Publicly Perform; (II) You may not offer or
impose any terms on the Adaptation that restrict the terms of the Applicable License
or the ability of the recipient of the Adaptation to exercise the rights granted to that
recipient under the terms of the Applicable License; (III) You must keep intact all
notices that refer to the Applicable License and to the disclaimer of warranties with
every copy of the Work as included in the Adaptation You Distribute or Publicly
Perform; (IV) when You Distribute or Publicly Perform the Adaptation, You may
not impose any effective technological measures on the Adaptation that restrict the
ability of a recipient of the Adaptation from You to exercise the rights granted to that
recipient under the terms of the Applicable License. This Section 4(b) applies to the
Adaptation as incorporated in a Collection, but this does not require the Collection
apart from the Adaptation itself to be made subject to the terms of the Applicable
License.

(¢) If You Distribute, or Publicly Perform the Work or any Adaptations or Collections,
You must, unless a request has been made pursuant to Section 4(a), keep intact all
copyright notices for the Work and provide, reasonable to the medium or means You
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are utilizing: (i) the name of the Original Author (or pseudonym, if applicable) if
supplied, and/or if the Original Author and/or Licensor designate another party or
parties (e.g., a sponsor institute, publishing entity, journal) for attribution (“Attribu-
tion Parties”) in Licensor’s copyright notice, terms of service or by other reasonable
means, the name of such party or parties; (ii) the title of the Work if supplied; (iii)
to the extent reasonably practicable, the URI, if any, that Licensor specifies to be
associated with the Work, unless such URI does not refer to the copyright notice or
licensing information for the Work; and (iv) , consistent with Ssection 3(b), in the
case of an Adaptation, a credit identifying the use of the Work in the Adaptation
(e.g., “French translation of the Work by Original Author,” or “Screenplay based on
original Work by Original Author”). The credit required by this Section 4(c) may
be implemented in any reasonable manner; provided, however, that in the case of a
Adaptation or Collection, at a minimum such credit will appear, if a credit for all
contributing authors of the Adaptation or Collection appears, then as part of these
credits and in a manner at least as prominent as the credits for the other contributing
authors. For the avoidance of doubt, You may only use the credit required by this
Section for the purpose of attribution in the manner set out above and, by exercising
Your rights under this License, You may not implicitly or explicitly assert or imply
any connection with, sponsorship or endorsement by the Original Author, Licensor
and/or Attribution Parties, as appropriate, of You or Your use of the Work, without
the separate, express prior written permission of the Original Author, Licensor and/or
Attribution Parties.

(d) Except as otherwise agreed in writing by the Licensor or as may be otherwise per-
mitted by applicable law, if You Reproduce, Distribute or Publicly Perform the Work
either by itself or as part of any Adaptations or Collections, You must not distort,
mutilate, modify or take other derogatory action in relation to the Work which would
be prejudicial to the Original Author’s honor or reputation. Licensor agrees that in
those jurisdictions (e.g. Japan), in which any exercise of the right granted in Section
3(b) of this License (the right to make Adaptations) would be deemed to be a distor-
tion, mutilation, modification or other derogatory action prejudicial to the Original
Author’s honor and reputation, the Licensor will waive or not assert, as appropriate,
this Section, to the fullest extent permitted by the applicable national law, to enable
You to reasonably exercise Your right under Section 3(b) of this License (right to make
Adaptations) but not otherwise.

5. Representations, Warranties and Disclaimer

UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING,
LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND CONCERNING THE WORK, EXPRESS, IMPLIED,
STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRAN-
TIES OF TITLE, MERCHANTIBILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS,
ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR
NOT DISCOVERABLE. SOME JURISDICTIONS DO NOT ALLOW THE EXCLU-
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SION OF IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO
YOU.

. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE
LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL
THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR
EXEMPLARY DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF
THE WORK, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES.

. Termination

(a) This License and the rights granted hereunder will terminate automatically upon any
breach by You of the terms of this License. Individuals or entities who have received
Adaptations or Collections from You under this License, however, will not have their
licenses terminated provided such individuals or entities remain in full compliance
with those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any termination of this
License.

(b) Subject to the above terms and conditions, the license granted here is perpetual (for
the duration of the applicable copyright in the Work). Notwithstanding the above,
Licensor reserves the right to release the Work under different license terms or to stop
distributing the Work at any time; provided, however that any such election will not
serve to withdraw this License (or any other license that has been, or is required to be,
granted under the terms of this License), and this License will continue in full force
and effect unless terminated as stated above.

. Miscellaneous

(a) Each time You Distribute or Publicly Perform the Work or a Collection, the Licensor
offers to the recipient a license to the Work on the same terms and conditions as the
license granted to You under this License.

(b) Each time You Distribute or Publicly Perform an Adaptation, Licensor offers to the
recipient a license to the original Work on the same terms and conditions as the license
granted to You under this License.

(c) If any provision of this License is invalid or unenforceable under applicable law, it
shall not affect the validity or enforceability of the remainder of the terms of this
License, and without further action by the parties to this agreement, such provision
shall be reformed to the minimum extent necessary to make such provision valid and
enforceable.

(d) No term or provision of this License shall be deemed waived and no breach consented
to unless such waiver or consent shall be in writing and signed by the party to be
charged with such waiver or consent.

(e) This License constitutes the entire agreement between the parties with respect to the
Work licensed here. There are no understandings, agreements or representations with
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respect to the Work not specified here. Licensor shall not be bound by any additional
provisions that may appear in any communication from You. This License may not
be modified without the mutual written agreement of the Licensor and You.

(f) The rights granted under, and the subject matter referenced, in this License were
drafted utilizing the terminology of the Berne Convention for the Protection of Literary
and Artistic Works (as amended on September 28, 1979), the Rome Convention of
1961, the WIPO Copyright Treaty of 1996, the WIPO Performances and Phonograms
Treaty of 1996 and the Universal Copyright Convention (as revised on July 24, 1971).
These rights and subject matter take effect in the relevant jurisdiction in which the
License terms are sought to be enforced according to the corresponding provisions of
the implementation of those treaty provisions in the applicable national law. If the
standard suite of rights granted under applicable copyright law includes additional
rights not granted under this License, such additional rights are deemed to be included
in the License; this License is not intended to restrict the license of any rights under
applicable law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty whatsoever in
connection with the Work. Creative Commons will not be liable to You or any party on any
legal theory for any damages whatsoever, including without limitation any general, special,
incidental or consequential damages arising in connection to this license. Notwithstanding
the foregoing two (2) sentences, if Creative Commons has expressly identified itself as the
Licensor hereunder, it shall have all rights and obligations of Licensor.

Except for the limited purpose of indicating to the public that the Work is licensed under
the CCPL, Creative Commons does not authorize the use by either party of the trademark
“Creative Commons” or any related trademark or logo of Creative Commons without the
prior written consent of Creative Commons. Any permitted use will be in compliance with
Creative Commons’ then-current trademark usage guidelines, as may be published on its
website or otherwise made available upon request from time to time. For the avoidance of
doubt, this trademark restriction does not form part of the License.

Creative Commons may be contacted at http://creativecommons.org/.


http://creativecommons.org/
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